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NOTES
(1)	The contents of this user’s manual may not be reprinted in part or whole without permission.

(2)	The contents of this user’s manual are subject to change without notice.

(3)	Great care has been taken in the preparation of this user’s manual; however, should you notice any questionable 
points, errors or omissions, please contact us.

(4)	Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed 
to result from using the Projector.
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Important Information
Safety Cautions
Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily 
accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical 
shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this 
unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS 
CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus complies with Canadian ICES-003.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic prod-
ucts carrying the mark (left) must be disposed of separately from normal household waste. This includes 
projectors and their electrical accessories or lamps. When you dispose of such products, please follow the 
guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us 
reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health 
and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member 
States.
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WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California 
to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those 
specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regu-
lation could void your right to operate this equipment. This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a 
particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•	 Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with 
this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them 
carefully and heed all warnings.

 Installation
•	 Do not place the projector in the following conditions:

-	 on an unstable cart, stand, or table.
-	 near water, baths, or damp rooms.
-	 in direct sunlight, near heaters, or heat radiating appliances.
-	 in a dusty, smoky or steamy environment. 
-	 on a sheet of paper or cloth, rugs or carpets.

•	 If you wish to have the projector installed on the ceiling:
-	 Do not attempt to install the projector yourself.
-	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 

of bodily injury.
-	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 

with any local building codes.
-	 Please consult your dealer for more information.
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WARNING
•	 Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of 

the cap due to the heat emitted from the light output.

•	 Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead 
to the object melting from the heat that is emitted from the light output.

•	 Do not spray flammable gas to get rid of dust and dirt that accumulate in the lens. Doing so could cause a 
fire.

Place the projector in a horizontal position
The tilt angle of the projector should not exceed 10 degrees, nor should the projector be installed in any way other 
than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

10˚

 Fire and Shock Precautions 
•	 Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your 

projector. Allow at least 4 inches (10cm) of space between your projector and a wall.
•	 Do not try to touch the exhaust vent on the right front (when seen from the front) as it can become heated while the 

projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily 
heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal 
projector operation.

	 Use caution when picking up the projector.

	

•	 Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve 
any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your 
projector. If something should fall into your projector, disconnect it immediately and have the object removed by a 
qualified service personnel.

•	 Do not place any objects on top of the projector.
•	 Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
•	 The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply 

fits this requirement before attempting to use your projector.
•	 Do not look into the lens while the projector is on. Serious damage to your eyes could result.

	

•	 Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the 
lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause 
unpredictable outcome such as fire or injury to the eyes.

•	 Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent.
	 Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the ex-

haust.
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•	 Do not splash water over the projector. Doing so can cause electrical shock or fire. If the projector gets wet, turn off 
the projector, unplug the power cord and have the projector serviced by a qualified service personnel.

•	 Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
-	 Do not use any power cord other than the one supplied with the projector.
-	 Do not bend or tug the power cord excessively.
-	 Do not place the power cord under the projector, or any heavy object.
-	 Do not cover the power cord with other soft materials such as rugs.
-	 Do not heat the power cord.
-	 Do not handle the power plug with wet hands.

•	 Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under 
the following conditions:
-	 When the power cord or plug is damaged or frayed.
-	 If liquid has been spilled into the projector, or if it has been exposed to rain or water. 
-	 If the projector does not operate normally when you follow the instructions described in this user’s manual.
-	 If the projector has been dropped or the cabinet has been damaged.
-	 If the projector exhibits a distinct change in performance, indicating a need for service.

•	 Disconnect the power cord and any other cables before carrying the projector.
•	 Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
•	 Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
•	 When using a LAN cable (only models with the RJ-45 LAN port):
	 For safety, do not connect to the connector for peripheral device wiring that might have excessive voltage.

 CAUTION
•	 Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hang-

ing on the wall can cause damage to the projector.
•	 Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the 

soft case could be damaged.
•	 Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select 

[SETUP] → [OPTIONS(1)] → [FAN MODE] → [HIGH].)
•	 Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blink-

ing blue. Doing so could cause premature lamp failure.

Remote Control Precautions

•	 Handle the remote control carefully.

•	 If the remote control gets wet, wipe it dry immediately.

•	 Avoid excessive heat and humidity.

•	 Do not short, heat, or take apart batteries.

•	 Do not throw batteries into fire.

•	 If you will not be using the remote control for a long time, remove the batteries.

•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.

•	 Do not use new and old batteries together, or use different types of batteries together.

•	 Dispose of used batteries according to your local regulations.
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Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement
•	 Use the specified lamp for safety and performance.
•	 To replace the lamp, follow all instructions provided on page 128.
•	 Be sure to replace the lamp when the message [THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. 

PLEASE REPLACE THE LAMP.] appears. If you continue to use the lamp after the lamp has reached the end of 
its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them 
as the pieces of glass may cause injury.

	 If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on 
and off will increase the possibility of its lower brightness.
The actual lamp life may vary depending upon the individual lamp, the environmental conditions and usage.

 CAUTION:
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off 

and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
•	 When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass 

fragments could fall if the lamp has been burned out.

About High Altitude mode

•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters 
or higher.

	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH ALTITUDE] 
can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and 
turn on the projector.

•	 Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTITUDE] 
can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].

•	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical com-
ponents such as the lamp.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue 
such as a coffee shop or hotel and employing compression or expansion of the screen image with the following func-
tions may raise concern about the infringement of copyrights which are protected by copyright law.
[ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yonetmeliğine Uygundur.
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Power management function
The projector has power management functions. To reduce power consumption, the power management functions (1 
and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable 
connection, use the on-screen menu to change the settings for 1 and 2.

1.	 STANDBY MODE (Factory preset: NORMAL)

	 To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE], the following connectors and functions will not work:
	 MONITOR OUT connector, AUDIO OUT connector, USB-B port, LAN functions, Mail Alert function, DDC/CI (Virtual Remote 
Tool)

2.	 AUTO POWER OFF (Factory preset: 1 hour)

	 To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

NOTE:
•	 When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is 
no signal received by any input or if no operation is performed.

 Health precautions to users viewing 3D images

Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your 
LCD shutter eyeglasses or your 3D compatible content such as DVDs, video games, computer's video files and 
the like.
To avoid any adverse symptoms, heed the following:
•	 Do not use LCD shutter eyeglasses for viewing any material other than 3D images.

•	 Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a 
distance can strain your eyes.

•	 Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour 
of viewing.

•	 If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D 
images.

•	 While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry 
vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor. 

•	 View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain. 
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7N8N4371)

•	 Quick Setup Guide 
	 (7N8N4381)/(7N8N4391)

NEC Projector CD-ROM
User’s manual (PDF) and the 
utility software
(7N952001)

1. Introduction
❶ What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer.
Please save the original box and packing materials if you ever need to ship your projector.

Unless otherwise described in the user’s manual, the drawings for the projector cabinet show examples of the 
M352WS.
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❷ Introduction to the Projector
This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector
This projector is one of the very best projectors available today. The projector enables you to project precise images 
up to 150 inches for short throw models across (measured diagonally) from your PC or Mac computer (desktop or 
notebook), VCR, DVD player, or document camera.
You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, 
and the projector can be permanently mounted on a ceiling*1. The remote control can be used wirelessly.

*1	 Do not attempt to mount the projector on a ceiling yourself.

	 The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk 
of bodily injury.

	 In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance 
with any local building codes. Please consult your dealer for more information.

 
Features you’ll enjoy:

•	 0.2 W (100-130 V AC)/ 0.38 W (200-240 V AC) in standby condition with energy saving technology

	 Selecting [NORMAL] for [STANDBY MODE] from the menu can put the projector in power-saving mode.

	 NORMAL: 0.2W(100-130V AC)/0.38W(200-240V AC)

	 NETWORK STANDBY: 2.5W(100-130V AC)/2.9W(200-240V AC)

•	 Carbon Meter 

	 This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO 
MODE] is set to [AUTO ECO], [NORMAL], or [ECO].

	 The amount of CO2 emission reduction will be displayed in the confirmation message at the time of power-off and 
in the INFO of the on-screen menu.

•	 Lamp life up to 8000 hours

	 Using in Eco Mode allows you to prolong the projector’s lamp life up to 8000 hours (up to 3500 hours in ECO 
MODE OFF). 

•	 No filter replacement required

	 Since the projector has no filters, filter replacement is not required.

•	 Two HDMI input ports provide digital signal 

	 The two HDMI inputs provide HDCP compatible digital signals. The HDMI input also supports audio signal.

•	 20 W built-in speaker for an integrated audio solution /mic input supprted

	 Powerful 20 watt monaural speaker provides volume need for large rooms a dynamic or condenser mic can be 
used.

•	 The supplied remote control allows you to assign a CONTROL ID to the projector

	 Multiple projectors can be operated separately and independently with the same single remote control by assigning 
an ID number to each projector.

•	 USB Display 

	 Using a commercially available USB cable (compatible with USB 2.0 specifications) to connect the computer with 
the projector allows you to send your computer screen image to the projector without the need of a traditional 
computer cable (VGA).
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•	 Integrated RJ-45 connector for wired networking capability along with wireless networking capabilities

	 An RJ-45 connector is standard. An optional USB Wireless LAN Unit is required for wireless LAN connection.

•	 Software programs (User Supportware) contained in the supplied CD-ROM

	 The supplied NEC Projector includes three programs: Virtual Remote Tool, Image Express Utility Lite (for Windows/
Mac OS), PC Control Utility Pro 4 (for Windows)/5 (for Mac OS). 

	 Image Express Utility Lite (for Windows) can be started from a commercially available USB memory or SD card 
without the need of installing on your computer.

•	 Audio transfer capability (for Windows only)

	 Image Express Utility Lite allows you to send the computer’s screen image and audio to the projector over a network 
or USB connection.

*	 Audio transfer capability is available only when the computer connects with the projector in peer-to-peer net-
work.

•	 AUTO POWER ON and AUTO POWER OFF features

	 The DIRECT POWER ON, AUTO POWER ON(COMP.), AUTO POWER OFF, and OFF TIMER features eliminate 
the need to always use the POWER button on the remote control or projector cabinet.

•	 AUTO POWER OFF Function

	 The projector is preset at the factory so that it will automatically turn off if there is no signal present after a preset 
duration. If you do not need this preset function, cancel it from the OSD menu. See page 102 for more informa-
tion.

•	 Preventing unauthorized use of the projector

	 Enhanced smart security settings for keyword protection, cabinet control panel lock, security slot, and security 
chain opening to help prevent unauthorized access, adjustments and theft deterrence.

•	 High resolution up to WUXGA

	 High resolution display - up to WUXGA compatible, XGA (M332XS)/WXGA (M352WS/M302WS) native resolu-
tion.

•	 3D Images supported

	 The projector provides 3D images to a user wearing commercially available 3D eyeglasses.

•	 CRESTRON ROOMVIEW compatibility

	 The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be man-
aged and controlled from a computer or controller.
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About this user’s manual
The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to 
review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find 
an overview. If the section doesn’t apply, you can skip it.
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Comparative Table of Main Features
The main features vary depending on the model as follows.

Short-Throw Models with Wide Panel Short-Throw Model
M352WS M302WS M332XS 

Native Aspect Ratio 16:10
Wide 

4:3
Standard

Native Resolution (dots × 
lines*1) 

WXGA (1280 × 800) XGA (1024 × 768)

Screen Size 60" - 150"
Projection Distance 22–58 inches/0.57–1.5 m 27–70 inches/0.68–1.8 m
Light output *2 *3 in OFF for 
ECO MODE 

3500 lumens 3000 lumens 3300 lumens

Lamp Replacement Time 
(average) 

OFF for ECO MODE/ON for ECO MODE (H)
3500/8000 3500/8000 3500/8000

Lamp Model NP30LP NP28LP NP30LP
Lamp Wattage (AC) 270 W 225 W 270 W
Zoom Using the [DIGITAL ZOOM] function from the menu
Focus Using the manual focus lever

For further details on the specifications, see pages 134 to 135.

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005

TIP: The model name is located on the cabinet.
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❸ Part Names of the Projector
Front/Top

Focus Lever
(→ page 23)

[M352WS/M302WS/M332XS]

Remote Sensor
(→ page 11) Exhaust Vent

Heated air is exhausted from here.

Lens Cap

Adjustable Tilt Foot Lever  
(→ page 21)

Adjustable Tilt Foot  
(→ page 21)

Lens

Security chain opening 
Attach an anti-theft device.
The security chain opening accepts 
security wires or chains up to 0.18 
inch/4.6 mm in diameter.

Controls
(→ page 8)

Port Cover for Optional USB  
Wireless LAN Unit 
When using the optional USB 
Wireless LAN Unit, first remove 
the cover. (→ page 125)

Light Sensor
(→ page 93)
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Rear
[M352WS/M302WS/M332XS]

*	 This security slot supports the MicroSaver ® Security System.

AC Input
Connect the supplied power cord’s 

three-pin plug here, and plug the 
other end into an active wall outlet. 

(→ page 16)

Built-in Security Slot (  )*

Terminal Panel (→ page 9)

Lamp Cover (→ page 128)

Rear Feet (→ page 21)

Intake Vent
(→ page 127)

Monaural Speaker (20 W)

Connection for cable cover (Left) 
Screw holes 

(→ page 137)

Connection for cable cover (Right) 
Screw holes 
(→ page 137)
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Top Features

1, 28 9 11

12

56 10

3

4

713

1.	  (POWER) Button 
	 (→ page 17, 27)

2.	 POWER Indicator 
	 (→ page 16, 17, 27, 131)

3.	 STATUS Indicator 
	 (→ page 131)

4.	 LAMP Indicator 
	 (→ page 128, 131)

5.	 ECO Button 
	 (→ page 31)

6.	 SOURCE Button 
	 (→ page 19)

7.	 AUTO ADJ. Button 
	 (→ page 26)

8.	 MENU Button 
	 (→ page 78)

9.	 ▲▼◀▶ / Volume Buttons ◀▶ / Keystone Buttons 
▲▼ 

	 (→ page 24, 26, 78)

10.	ENTER Button 
	 (→ page 78)

11.	EXIT Button 
	 (→ page 78)

12.	Wireless LAN Indicator ( )
	 When the projector is turned on with the optional wire-

less LAN unit inserted, the indicator will light up blue.
	 (→ page 124)

13.	ECO Indicator
	 When [ECO MODE] is set to the other options than 

[OFF], this indicator will light up green.
	 (→ page 31)

NOTE: 
•	 All the buttons except ▲▼◀▶ will light when pressed.
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Terminal Panel Features

12 46

1413

7

98

1211 10 35

1.	 COMPUTER IN/ Component Input Connector 
(Mini D-Sub 15 Pin) 

	 (→ page 117, 119, 121)

2.	 COMPUTER AUDIO IN Mini Jack (Stereo Mini) 
	 (→ page 117, 119, 121)

3.	 HDMI 1 IN Connector (Type A) 
	 (→ page 117, 122)

4.	 HDMI 2 IN Connector (Type A) 
	 (→ page 117, 122)

5.	 USB-B Port (Type B) 
	 (→ page 42, 43)

6.	 MONITOR OUT (COMP.) Connector (Mini D-Sub 
15 Pin) 

	 (→ page 121)

7.	 AUDIO OUT Mini Jack (Stereo Mini) 
	 (→ page 121)

8.	 VIDEO IN Connector (RCA) 
	 (→ page 120)

9.	 VIDEO AUDIO IN L/MONO, R (RCA) 
	 (→ page 120)

10.	MIC Input Jack (Monaural Mini)
	 (→ page 69)

11.	LAN Port (RJ-45) 
	 (→ page 123)

12.	USB-A Port (Type A) 
	 (→ page 72)

13.	3D SYNC (Mini DIN 4 Pin)
	 (→ page 65)

14.	PC CONTROL [PC CONTROL] Port (D-Sub 9 Pin) 
	 (→ page 140)
	 Use this port to connect a PC or control system. This 

enables you to control the projector using serial commu-
nication protocol. If you are writing your own program, 
typical PC control codes are on page 140.
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❹ Part Names of the Remote Control

3
4
6
7

1

2

10
16

17
15
14

9

5
8

13

30

31
32

20
21
26
28

29
2524

23
22

27

33

19
18

12
11

1.	 Infrared Transmitter
	 (→ page 11)

2.	 POWER ON Button
	 (→ page 17, 27)

3.	 STANDBY Button
	 (→ page 27)

4.	 SOURCE Button
	 (→ page 19)

5, 6. COMP1/COMP2 Button
	 (→ page 19) 
	 (COMP2 button does not work in 

this series of projectors.)

7.	 AUTO ADJ. Button
	 (→ page 26)

8, 9. HDMI1/HDMI2 Button 
	 (→ page 19)

10.	DisplayPort Button 
	 (This button does not work in this 

series of projectors)
	 (→ page 19)

11.	VIDEO Button
	 (→ page 19)

12.	USB-A Button
	 (→ page 19, 72)

13.	USB-B Button 
	 (→ page 19)

14.	LAN Button 
	 (→ page 19)

15.	ID SET Button
	 (→ page 98)

16.	Numeric Keypad Button/
CLEAR Button

	 (→ page 98)

17.	FREEZE Button
	 (→ page 29)

18.	AV-MUTE Button
	 (→ page 29)

19.	MENU Button
	 (→ page 78)

20.	EXIT Button 
	 (→ page 78)

21.	▲▼◀▶ Button 
	 (→ page 78)

22.	ENTER Button 
	 (→ page 78)

23.	D-ZOOM (+)(–) Button
	 (→ page 29)

24.	MOUSE L-CLICK Button*
	 (→ page 42)

25.	MOUSE R-CLICK Button*
	 (→ page 42)

26.	PAGE ▽/△ Button
	 (→ page 42)

27.	ECO Button 
	 (→ page 31)

28.	KEYSTONE Button
	 (→ page 24)

29.	PICTURE Button
	 (→ page 84, 86)

30.	VOL. (+)(–) Button
	 (→ page 26)

31.	ASPECT Button
	 (→ page 89)

32.	FOCUS/ZOOM Button
	 The ZOOM button works on the 

short-throw models only. The 
FOCUS button does not work on 
this series of projectors.

33.	HELP Button
	 (→ page 109)

*	 The MOUSE L-CLICK and MOUSE R-CLICK buttons work only when a USB cable is connected with your computer.
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Remote Control Precautions
•	 Handle the remote control carefully.
•	 If the remote control gets wet, wipe it dry immediately.
•	 Avoid excessive heat and humidity.
•	 Do not short, heat, or take apart batteries.
•	 Do not throw batteries into fire.
•	 If you will not be using the remote control for a long time, remove the batteries.
•	 Ensure that you have the batteries’ polarity (+/−) aligned correctly.
•	 Do not use new and old batteries together, or use different types of batteries together.
• 	 Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

22 feet/7 m

22 feet/7 m

Remote control

Remote sensor on projector cabinet

Remote control

•	 The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of 
the remote sensor on the projector cabinet.

•	 The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls 
on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.

1 Press firmly and slide the battery 
cover off.

2 Install new batteries (AAA). Ensure 
that you have the batteries’ polarity 
(+/−) aligned correctly.

Battery Installation

3 Slip the cover back over the bat-
teries until it snaps into place. Do 
not mix different types of batteries 
or new and old batteries.

OP
EN

OP
EN
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❺ Operating Environment for Software Included on CD-ROM
Names and Features of Bundled Software Programs

Name of software program Features

Virtual Remote Tool
(Windows only)

This is a software program used to control the power ON/OFF and source selec-
tion of the projector from your computer by using the supplied computer cable 
(VGA) and others. (→ page 36)

Name of software program Features

Image Express Utility Lite •	 This is a software program used to project your computer’s screen or sound 
from the computer over the USB cable or the wired/wireless network. The 
computer cable (VGA) is not required. (→ page 56)

•	 This software program can be used to control the power ON/OFF and source 
selection of the projector from your computer.

•	 The Geometric Correction Tool (GCT) function allows you to correct distortion 
of images projected on a curved wall. (→ page 63)

Image Express Utility Lite for 
Mac OS

•	 This is a software program used to project your computer's screen over the 
wired/wireless network. The computer cable (VGA) is not required. (→ page 
56, 61) 

•	 This software program can be used to control the power ON/OFF and source 
selection of the projector from your computer. 
*	 “Audio transmission”, “USB Display”, and “GCT” functions are not supported 

by Mac.

Name of software program Features

PC Control Utility Pro 4
PC Control Utility Pro 5 (for Mac 
OS)

This is a software program used to operate the projector from the computer when 
the computer and the projector are connected with LAN (wired or wireless) or 
a serial cable. (→ page 52)

NOTE:
•	 Image Express Utility Lite does not support "Meeting Mode" in Image Express Utility 2.0 included with our other models.

Download service
For the update information about these software programs, visit our website:
URL: http://www.nec-display.com/dl/en/index.html
 

http://www.nec-display.com/dl/en/index.html
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Operating Environment
The following is the operating environment for Image Express Utility Lite. For the operating environment of other soft-
ware program, refer to the help function of each software program.

[Windows]

Supported OS Windows 8 (Core Edition)
Windows 8 Pro
Windows 8 Enterprise
Windows 7 Home Basic
Windows 7 Home Premium
Windows 7 Professional
Windows 7 Ultimate
Windows 7 Enterprise
Windows Vista Home Basic
Windows Vista Home Premium
Windows Vista Business
Windows Vista Ultimate
Windows Vista Enterprise
Windows XP Home Edition (32-bit version) Service Pack 3 or later
Windows XP Professional (32-bit version) Service Pack 3 or later
•	 Windows power-saving function is not supported.
•	 To use the audio transfer capability, Windows 8/Windows 7/Windows Vista 

Service Pack 1 or later is required.

Processor •	 Windows 8/Windows 7/Windows Vista
Pentium M 1.2 GHz equivalent or higher required
Dual core 1.5 GHz or higher recommended

•	 Windows XP
Pentium M 1.0 GHz equivalent or higher required
Dual core 1.0 GHz or higher recommended

Memory •	 Windows 8/Windows 7/Windows Vista
512 MB or more required
1 GB or more recommended

•	 Windows XP
256 MB or more required
512 MB or more recommended
* More memory may be required to run additional applications simultane-
ously.

Graphic processor •	 Windows 8/Windows 7/Windows Vista
The “Graphics” score 3.0 or more of “Windows Experience Index” recom-
mended.

Network environment TCP/IP-compatible wired LAN or wireless LAN
*	 Use a wireless LAN unit complying with the Wi-Fi standard.
*	 Audio transfer capability requires 3 Mbps or more throughput.

Resolution •	 Windows 8/Windows 7/Windows Vista 
SVGA (800 × 600) or higher required
XGA (1024 × 768) recommended 

•	 Windows XP 
VGA (640 × 480) or higher required
XGA (1024 × 768) recommended

1024 dots × 768 lines - 1280 dots × 800 lines recommended (M352WS/
M302WS)

Screen Colors High Color (15 bits, 16 bits)
True Color (24 bits, 32 bits) (recommended)
•	 256 or fewer colors are not supported.
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[Mac]

Supported OS Mac OS X v10.6, v10.7, v10.8

Processor (CPU) Intel® Core™ Duo processor 1.5 GHz or higher required
Intel® Core™ 2 Duo processor 1.6 GHz or higher recommended
*	 PowerPC® is not supported

Memory 512 MB or higher required

Network environment Wired or wireless LAN required that supports TCP/IP
*	 The following LAN adapters are verified to work with Image Express Utility 

Lite:
•	 Wired LAN adapter built into Mac
•	 Wireless LAN adapter built into Mac
•	 Apple USB Ethernet adapter

“Easy Connection” supports only wireless LAN.

Supported Resolution SVGA (800 × 600) or higher required
XGA (1024 × 768) recommended
(1024 × 768 – 1280 × 800 recommended for M352WS/M302WS)

Supported Screen Colors 16.70 million colors required
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This section describes how to turn on the projector and to project a picture onto the screen.

❶ Flow of Projecting an Image

Step 1
•	 Connecting your computer / Connecting the power cord (→ page 16)

	

Step 2 
•	 Turning on the projector (→ page 17)

	

Step 3 
•	 Selecting a source (→ page 19)

	

Step 4
•	 Adjusting the picture size and position (→ page 20)

•	 Correcting keystone distortion [KEYSTONE] (→ page 24)

	

Step 5
•	 Adjusting a picture and sound

-	 Optimizing a computer signal automatically (→ page 26)

-	 Turning up or down volume (→ page 26)

	

Step 6
•	 Making a presentation

	

Step 7
•	 Turning off the projector (→ page 27)

	

Step 8
•	 After use (→ page 28)

2. Projecting an Image (Basic Operation)
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2. Projecting an Image (Basic Operation)

❷ Connecting Your Computer/Connecting the Power Cord

1.	 Connect your computer to the projector.

	 This section will show you a basic connection to a computer. For information about other connections, see “6. 
Installation and Connections” on page 117.

	 Connect the computer cable (VGA) between the projector’s COMPUTER IN connector and the computer’s port 
(mini D-Sub 15 Pin). Turn two thumb screws of both connectors to fix the computer cable (VGA).

2.	 Connect the supplied power cord to the projector.

	 First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other 
plug of the supplied power cord in the wall outlet.

	 The projector’s power indicator will light red* (standby mode).

	 See the Power Indicator section.(→ page 131) 

COMPUTER IN

Make sure that the prongs are fully inserted into 
both the AC IN and the wall outlet.

To wall outlet

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.
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Standby Blinking Power On

Steady red light Blinking blue 
light

Steady blue 
light

❸ Turning on the Projector
1.	 Remove the lens cap.

2.	 Press the  (POWER) button on the projector cabinet 
or the POWER ON button on the remote control. 

	 The POWER indicator will turn to blue and the projector 
will become ready to use.

TIP: 
•	 When the message “Projector is locked! Enter your password.” 
is displayed, it means that the [SECURITY] feature is turned on. 
(→ page 33)

	 After you turn on your projector, ensure that the computer 
or video source is turned on and that the lens cover is 
open.

NOTE: When no input signal is present, the no-signal guidance is 
displayed (factory menu setting).

(→ page 131)

Lens cap
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Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one 
of the menu languages.

To select a menu language, follow these steps:

1.	 Use the ▲, ▼, ◀ or ▶ button to select one of the lan-
guages from the menu.

2.	 Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu 
operation.
If you want, you can select the menu language later.
(→ [LANGUAGE] on page 80 and 94)

NOTE: 
•	 When turning off the power supply and then back on by using a power strip or breaker.
	 Allow a minimum of 1 second between turning off the main power supply and turning it back on again.
	 Failing to do so could result in no power to the projector. (There will be no stand-by LED) 
	 Should this happen, unplug the power cord and plug it in again. Turn on the main power.
•	 If one of the following things happens, the projector will not turn on.
•	 If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the 
projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool 
down.

•	 When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
•	 If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. 
Cancel the lock by turning it off. (→ page 97)

•	 If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and then turn on 
the power.

•	 While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
•	 Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is 
stabilized.

•	 When the projector is turned on, it may take some time before the lamp light becomes bright.
•	 If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without display-
ing an image for some time and then the projector will display the image.
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❹ Selecting a Source
Selecting the computer or video source
NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the SOURCE button once. The projector will search for the available 
input source and display it. The input source will change as follows: 

COMPUTER → HDMI1 → HDMI2 → VIDEO → USB-A → LAN → USB-B 
→ COMPUTER → ...

•	 With the SOURCE screen displayed, you can press the SOURCE 
button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control
Press any one of the COMP1, HDMI1, HDMI2, VIDEO, USB-A, LAN, or 
USB-B buttons.

Selecting Default Source 
You can set a source as the default source so that it will be displayed 
each time the projector is turned on.

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ▶ button twice to select [SETUP] and press the ▼ but-
ton or the ENTER button to select [GENERAL].

3.	 Press the ▶ button four times to select [OPTIONS(2)].

4.	 Press the ▼ button five times to select [DEFAULT SOURCE SE-
LECT] and press the ENTER button.

	 The [DEFAULT SOURCE SELECT] screen will be displayed.

	 (→ page 102)

5.	 Select a source as the default source, and press the ENTER but-
ton.

6.	 Press the EXIT button a few times to close the menu.

7.	 Restart the projector.

	 The source you selected in step 5 will be projected.

TIP: 
•	 When the projector is in Standby mode, applying a computer signal from a 
computer connected to the COMPUTER IN input will power on the projector 
and simultaneously project the computer’s image.

	 ([AUTO POWER ON(COMP.)] → page 102)
•	 On Windows 7, a combination of the Windows and P keys allows you to set up 
external display easily and quickly.
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❺ Adjusting the Picture Size and Position
Use the adjustable tilt foot, the zoom function or the focus ring to adjust the picture size and position.
In this chapter drawings and cables are omitted for clarity.

Adjusting the throw angle (the height of an image)
[Tilt foot] (→ page 21)

Adjusting the left and right tilt of an image
[Rear foot] (→ page 21)

Finely adjusting the size of an image
[Zoom lever] (→ page 22)

Adjusting the focus
[Focus ring] (→ page 23)

Adjusting the keystone correction [KEYSTONE]* (→ page 24)

*	 Automatic Keystone Correction function is turned on at the time of shipment. To perform keystone correction manually, see “6. 
Correcting Keystone Distortion Manually” on page 24.
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2

1

3

Adjustable Tilt Foot

Adjustable Tilt 
Foot Lever

Adjust the Tilt Foot
1. 	Lift the front edge of the projector.

 CAUTION:
Do not try to touch the exhaust vent during Tilt Foot adjustment as 
it can become heated while the projector is turned on and after it is 
turned off.

2. 	Push up and hold the Adjustable Tilt Foot Lever on the front of 
the projector to extend the adjustable tilt foot.

3. 	Lower the front of the projector to the desired height.

4. 	Release the Adjustable Tilt Foot Lever to lock the Adjustable tilt 
foot.

	 The tilt foot can be extended up to 2 inches/52 mm.

	 There is approximately 10 degrees (up) of adjustment for the front of 
the projector.

	 Rotate the rear foot to the desired height in order to square the image 
on the projection surface.

 CAUTION:
•	 Do not use the tilt-foot for purposes other than originally intended.
	 Misuses such as using the tilt foot to carry or hang (from the wall or 

ceiling) the projector can cause damage to the projector.

Adjusting the left and right tilt of an image [Rear foot]
•	 Rotate the rear foot.

	 The rear foot can be extended up to 1 inch/26.5 mm. Rotating the rear 
foot allows the projector to be placed horizontally.

NOTE:
•	 Do not extend the rear foot beyond its height limit (1 inch/26.5 mm). Doing so 
may cause the rear foot to come out of the projector. 

•	 If extending the left rear foot (viewed from the rear) causes the protrusion to 
interfere with the floor, extend the right rear foot by 0.5 inch/12 mm or longer. 
If extending the right rear foot causes the protrusion to interfere with the floor, 
extend the left rear foot by 0.3 inch/8 mm.

 Rear feet

Up Down
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Zoom
The image size can be adjusted electronically from the menu. To do so, follow the steps below.
Adjusting with the ZOOM button on the remote control
1.	 Press the ZOOM button. 

	 The DIGITAL ZOOM bar will be displayed.

2.	 Press the ◀ or ▶ button to adjust the image size. 

3.	 Press the EXIT button.

	 The DIGITAL ZOOM bar will be closed. 
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Focus
Use the FOCUS lever to obtain the best focus.

Focus Lever
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❻ Correcting Keystone Distortion Manually
If the screen is tilted vertically, keystone distortion becomes large. Automatic Keystone Correction function is turned on 
at the time of shipment. To correct keystone distortion manually, proceed with the following steps to correct keystone 
distortion. 

 

NOTE: 
•	 The Keystone correction can cause an image to be slightly blurred because the correction is made electronically.
•	 The Keystone correction range can be made narrower, depending on a signal or its aspect ratio selection.

Adjusting with buttons on the cabinet
1.	 Press the ▲ or ▼ button with no menus displayed.

	 The keystone bar will be displayed.

      

2.	 Use the ▲ or ▼ to correct the keystone distortion.

	 The keystone bar will be closed after a period of time.

3.	 Press the ENTER button.

	 The keystone bar will be closed.

NOTE: 
•	 When the menu is displayed, the above operation is not available. When the menu is displayed, press the MENU button to close 
the menu and start the Keystone correction.

	 From the menu, select [SETUP] → [GENERAL] → [KEYSTONE]. The changes can be saved with [KEYSTONE SAVE]. (→ page 
92)

•	 Keystone control is not available with the ▲ or ▼ button when the [USB-B] input is used.
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Adjusting with the remote control
1.	 Press the KEYSTONE button.

	 The Keystone bar will be displayed.

	

2.	 Use the  ◀ or ▶ button to correct the keystone distortion.

	 Adjust so that the right and left sides are parallel.

	

3.	 Press the EXIT button.

	 The Keystone bar will be closed.
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❼ Optimizing Computer Signal Automatically
Adjusting the Image Using Auto Adjust
Optimizing a computer image automatically. (COMPUTER)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]

[Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
•	 If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] 
manually. (→ page 87, 88)

❽ Turning Up or Down Volume
Sound level from the speaker can be adjusted.

TIP: When no menus appear, the ◀ and ▶ buttons on the projector cabinet work 
as a volume control. 

NOTE:
•	 Volume control is not available with the ◀ or ▶ button when an image is enlarged 
by using the D-ZOOM (+) button or when the menu is displayed.

•	 Volume control is not available with the ◀ or ▶ button when VIEWER is 
used.

TIP: The [BEEP] sound volume cannot be adjusted. To turn off the [BEEP] sound, 
from the menu, select [SETUP] → [OPTIONS (1)] → [BEEP] → [OFF].

Increase volume

Decrease volume
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❾ Turning off the Projector
To turn off the projector:

1.	 First, press the  (POWER) button on the projector 
cabinet or the STANDBY button on the remote con-
trol. 

	 The confirmation message will be displayed.

2.	 Secondly, press the ENTER button or press the  
(POWER) or the STANDBY button again.

	 After the projector turns off, the cooling fans keep operating 
for a while (Cooling-off time).

	 The cooling fans stop operating when the projector turns 
off and goes into standby mode. When in standby mode, 
the POWER indicator will light red and the STATUS indica-
tor will light off when [NORMAL] is selected for [STANDBY 
MODE]. 

Power On

Steady blue light

Standby

Steady  
red light

 CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the 
AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.

NOTE:
•	 While the power indicator is blinking blue in short cycles, the power cannot be turned off.
•	 You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
•	 Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing 
the menu. Doing so can cause loss of adjustments and settings.
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❿ After Use
Preparation: Make sure that the projector is turned off.

1.	 Unplug the power cord.

2.	 Disconnect any other cables.
•	 Remove the USB memory if it is inserted into the projector.

3.	 Retract adjustable tilt foot if extended.

4. Reattach the lens cap

	

1

2

①	 Put the lens cap on the top of the lens.

② Push to cover the lens completely.

 CAUTION:
Use caution when putting the projector in the soft case immediately after the projector has been operating. The 
projector cabinet is hot.
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❶ Turning off the Image and Sound
Press the AV-MUTE button to turn off the image and sound for a short 
period of time. Press again to restore the image and sound.

The projector’s power-saving function will work 10 seconds after the im-
age is turned off.

As a result, the lamp power will be reduced.

NOTE:
•	 Even though the image is turned off, the menu still remains on the screen.
•	 Sound from the AUDIO OUT jack (Stereo mini) can be turned off.
•	 Even when the power-saving function works, the lamp power may be restored 
to its original level temporarily.

•	 To restore the image, even if you press the AV-MUTE button immediately after 
the start of the power-saving function, the lamp brightness may not be restored 
to its original level.

❷ Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume 
motion.

NOTE: 
•	 The image is frozen but the original video is still playing back.
•	 With Image Express Utility including USB Display, pressing the FREEZE button 
will eliminate sound temporarily during display of freezed image.

❸ Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on 
the signal.

To do so:

1.	 Press the D-ZOOM (+) button to magnify the picture.

	 To move the magnified image, use the ▲,▼,◀ or ▶ button.

3. Convenient Features
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2.	 Press the ▲▼◀▶ button.
	 The area of the magnified image will be moved

3.	 Press the D-ZOOM (−) button.

	 Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE: 
•	 The image will be enlarged or reduced at the center of the screen.
•	 Displaying the menu will cancel the current magnification.
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❹ Changing Eco Mode/Checking Energy-Saving Effect 
Using Eco Mode [ECO MODE]
The ECO MODE (NORMAL and ECO) increases lamp life, while lowering power consumption and cutting down on 
CO2 emissions. 
Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes. 

[ECO MODE] Description
Status of LAMP 
indicator

Status of 
ECO indi-
cator

[OFF] The lamp brightness is 100%.
Off Off

[AUTO ECO] Lamp power consumption will be controlled between 
[OFF] and [ECO] automatically according to picture 
level.
NOTE: A bright gradation may be less visible depending on 
the image.

Steady 
Green light

Steady 
Green light

[NORMAL] Lamp power consumption. (approx.81% brightness on 
M352WS/M332XS and approx. 76% on M302WS) The 
lamp life will extend by lowering the lamp power.

[ECO] Lamp power consumption (approx. 60% brightness). 
The lamp life will extend longer than the one on NOR-
MAL mode by controlling power appropriate for the 
lamp. The maximum power becomes equivalent to the 
power in NORMAL.

To turn on the [ECO MODE], do the following: 
1.	 Press the ECO Button on the remote control to display [ECO MODE] screen.

2.	 Press the ECO button again to select a mode you wish. 

•	 Each time the ECO button is pressed, the choices will be changed:

	 OFF → AUTO ECO → NORMAL → ECO → OFF

TIP: 
•	 The leaf symbol at the bottom of the menu shows the current selection of ECO mode.

NOTE: 
•	 Immediately after the menu item is selected for [ECO MODE], the screen may flicker. This is not malfunction.
•	 The [ECO MODE] can be changed by using the menu.
	 Select [SETUP] → [GENERAL] → [ECO MODE].
•	 The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] →[USAGE TIME].
•	 The projector is always in [NORMAL] for 90 seconds after the lamp is turned on and while the POWER indicator is blinking green. 
The lamp condition will not be affected even when [ECO MODE] is changed.

•	 After a lapse of 1 minute from when the projector displays no-signal guidance, a blue, black or logo screen, [ECO MODE] will 
automatically switch to [ECO].

•	 If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [NORMAL] 
mode to protect the projector. When the projector is in [NORMAL] mode, the picture brightness decreases. When the projector 
comes back to normal temperature, the [ECO MODE] returns to [OFF] mode.

	 Thermometer symbol [  ] indicates the [ECO MODE] is automatically set to [NORMAL] mode because the internal temperature 
is too high.
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Checking Energy-Saving Effect [CARBON METER]
This feature will show energy-saving effect in terms of CO2 emission reduction (kg) when the projector’s [ECO MODE] 
is set to [AUTO ECO], [NORMAL], or [ECO]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON 
SAVINGS] message shows the total amount of CO2 emission reduction from the time of shipment up to now. You can 
check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 109)

The [CARBON SAVINGS-SESSION] message shows the amount of CO2 emission reduction between the time of 
changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-
SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:
•	 The formula as shown below is used to calculate the amount of CO2 emission reduction.
	 Amount of CO2 emission reduction = (Power consumption in OFF for ECO MODE − Power consumption in AUTO ECO/NORMAL/
ECO for ECO MODE) × CO2 conversion factor.* When the image is turned off with the AV-MUTE button or with the lens cover 
closed, the amount of CO2 emmission reduction will also increase.

	 * �Calculation for amount of CO2 emission reduction is based on an OECD publication “CO2 Emissions from Fuel Combustion, 2008 
Edition”.

•	 The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
•	 This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
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❺ Preventing the Unauthorized Use of the Projector [SECURITY]
A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword 
is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the pro-
jector cannot project an image. 
• The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1.	 Press the MENU button.

	 The menu will be displayed.

2.	 Press the ▶ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [GEN-
ERAL].

3.	 Press the ▶ button to select [INSTALLATION].

4.	 Press the ▼ button three times to select [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

5. 	Press the ▼ button to select [ON] and press the ENTER button.

	 The [SECURITY KEYWORD] screen will be displayed.

6.	 Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length.

	 The [CONFIRM KEYWORD] screen will be displayed.
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7.	 Type in the same combination of ▲▼◀▶ buttons and press the ENTER button.

	 The confirmation screen will be displayed.

8.	 Select [YES] and press the ENTER button.

	 The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1.	 Press the POWER button.

	 The projector will be turned on and display a message to the effect that the projector is locked.

2.	 Press the MENU button.

3.	 Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
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To disable the SECURITY function:

1.	 Press the MENU button.

	 The menu will be displayed.

2. 	Select [SETUP] → [INSTALLATION] → [SECURITY] and press the ENTER button.

	 The OFF/ON menu will be displayed.

3.	 Select [OFF] and press the ENTER button.

	 The SECURITY KEYWORD screen will be displayed.

4.	 Type in your keyword and press the ENTER button.

	 When the correct keyword is entered, the SECURITY function will be disabled.

NOTE: If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request 
code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] 
is a request code.



36

3. Convenient Features

❻ Using the Computer Cable (VGA) to Operate the 
Projector (Virtual Remote Tool)
Using the utility software “Virtual Remote Tool” included on the companion NEC Projector CD-ROM, Virtual Remote 
screen (or toolbar) can be displayed on your computer screen.
This will help you perform operations such as projector’s power on or off and signal selection via the computer cable 
(VGA), serial cable, or LAN connection.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, and remote control operation on your 
PC.

Virtual Remote screen Toolbar

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 41)

Step 1: Install Virtual Remote Tool on the computer. (→ page 37)
Step 2: Connect the projector to the computer. (→ page 39)
Step 3: Start Virtual Remote Tool. (→ page 40)

TIP:
•	 Virtual Remote Tool can be used with a LAN and a serial connection. USB connection is not supported by Virtual Remote Tool.
•	 For update information on Virtual Remote Tool, visit our website: 
	 http://www.nec-display.com/dl/en/index.html

http://www.nec-display.com/dl/en/index.html
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NOTE:
•	 When [COMPUTER] is selected from your source selection, the Virtual Remote screen or the toolbar will be displayed as well as 
your computer screen.

•	 Use the supplied computer cable (VGA) to connect the COMPUTER IN connector directly with the monitor output connector of 
the computer to use Virtual Remote Tool.

	 Using a switcher or other cables than the supplied computer cable (VGA) may cause failure in signal communication.
	 VGA cable connector:
	 Pin Nos. 12 and 15 are required for DDC/CI.
•	 Virtual Remote Tool may not work depending on your computer’s specifications and version of graphic adapters or drivers.
•	 To run Virtual Remote Tool on Windows 8 and Windows XP, “Microsoft .NET Framework Version 2.0” is required. The Microsoft 
.NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install the it on your computer. 

TIP:
•	 The projector’s COMPUTER IN connector supports DDC/CI (Display Data Channel Command Interface). DDC/CI is a standard 
interface for bidirectional communication between display/projector and computer.

Step 1: Install Virtual Remote Tool on the computer

NOTE:
•	 To install Virtual Remote Tool, the Windows user account must have “Administrator” privilege (Windows 8, Windows 7, Windows 
Vista and Windows XP). 

•	 Exit all running programs before installing Virtual Remote Tool. If another program is running, the installation may not be com-
pleted. 

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.

2	 Click “Install Virtual Remote Tool” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.
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TIP:

Uninstalling Virtual Remote Tool
Preparation:
Exit Virtual Remote Tool before uninstalling. To uninstall Virtual Remote Tool, the Windows user account must have 
“Administrator” privilege (Windows 8, Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows 
XP).

• For Windows 7/Windows Vista
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Click “Uninstall a program” under “Programs”

	 The “Programs and Features” window will be displayed.

3	 Select Virtual Remote Tool and click it.

4	 Click “Uninstall/Change” or “Uninstall”.

	 • When the “User Account Control” windows is displayed, click “Continue”.

	 Follow the instructions on the screens to complete the uninstallation.

• For Windows XP
1	 Click “Start” and then “Control Panel”.

	 The Control Panel window will be displayed.

2	 Double-click “Add / Remove Programs”.

	 The Add / Remove Programs window will be displayed.

3	 Click Virtual Remote Tool from the list and then click “Remove”.

	 Follow the instructions on the screens to complete the uninstallation.

Step 2: Connect the projector to the computer
1	 Use the supplied computer cable (VGA) to connect the COMPUTER IN connector of the projector directly 

with the monitor output connector of the computer.

2	 Connect the supplied power cord to the AC IN of the projector and the wall outlet.

	 The projector is in the standby condition.

AC IN

COMPUTER IN

Supplied computer cable (VGA)

To wall outlet
Power cord (supplied)

TIP:
•	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed to navigate your connections.
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Step 3: Start Virtual Remote Tool

Start using the shortcut icon
•	 Double-click the shortcut icon  on the Windows Desktop.

Start from the Start menu
•	 Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] 

→ [Virtual Remote Tool].

	 When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

	 Follow the instructions on the screens

	 When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the computer cable 
(VGA) or network (wired LAN/wireless LAN) connection.

TIP:
•	 The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
	 To do so, click to place a check mark for “  Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.
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Exiting Virtual Remote Tool
1	 Click the Virtual Remote Tool icon  on the Taskbar.

	 The pop-up menu will be displayed.

2	 Click “Exit”.

	 The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool
• Displaying the help file using the taskbar
1	 Click the Virtual Remote Tool icon  on the taskbar when Virtual Remote Tool is running.

	 The pop-up menu will be displayed.

2.	 Click “Help”.

	 The Help screen will be displayed.

• Displaying the help file using the Start Menu.
1.	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Virtual Remote 

Tool” → and then “Virtual Remote Tool Help” in this order.

	 The Help screen will be displayed.
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❼ Operating Your Computer’s Mouse Functions from the 
Projector’s Remote Control via the USB Cable (Remote Mouse 
Function)
The built-in remote mouse function enables you to operate your computer’s mouse functions from the supplied remote 
control when the projector is connected to a computer via a commercially available USB cable (compatible with USB 
2.0 specifications).
The Remote Mouse function works for the COMPUTER input while the computer screen is displayed.
The Remote Mouse function will not work while you freeze or magnify an image.
-	 Using the USB cable to connect the projector and the computer will also start USB Display function.

AC IN

USB-B

USB cable (not supplied)

To wall outlet

NOTE:
•	 A USB cable must support the USB 2.0 Specifications.
•	 The mouse function can be used with the following operating systems:
	 Windows 7, Windows XP, or Windows Vista
•	 In SP2 or older version of Windows XP, if the mouse cursor will not move correctly, do the following:
	 Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer 
Options tab].

•	 Wait at least 5 seconds after disconnecting the USB cable before reconnecting it and vice versa. The computer may not identify 
the USB cable if it is repeatedly connected and disconnected in rapid intervals.

•	 Connect the projector to the computer with a USB cable after starting the computer. Failure to do so may fail to start the com-
puter.

Operating your computer’s mouse from the remote control
You can operate your computer’s mouse from the remote control.

PAGE ▽/△ Button	���������������������������scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint 
on your computer.

▲▼◀▶ Buttons	������������������������������moves the mouse cursor on your computer.
MOUSE L-CLICK/ENTER Button	������works as the mouse left button.
MOUSE R-CLICK Button	������������������works as the mouse right button.

NOTE:
•	 When you operate the computer using the ▲▼◀ or ▶ button with the menu displayed, both the menu and the mouse pointer 
will be affected. Close the menu and perform the mouse operation.

TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user 
documentation or online help supplied with your computer.
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❽ Projecting Your Computer’s Screen Image from the 
Projector via the USB Cable (USB Display)
Using a commercially available USB cable (compatible with USB 2.0 specifications) to connect the computer with the 
projector allows you to send your computer screen image to the projector for displaying. Power On/Off and source 
selection of the projector can be done from your computer without connecting a computer cable (VGA).

NOTE:
•	 To make USB DISPLAY available on Windows 8, Windows 7, Windows Vista and Windows XP, the Windows user account must 
have “Administrator” privilege.

•	 USB Display uses functions of Image Express Utility Lite contained on NEC Projector CD-ROM (→ page 56).
	 Starting USB Display, however, will not install Image Express Utility Lite on your computer. This is because USB Display executes 
the projector’s program only. 

•	 When Image Express Utility Lite is installed to both your computer and the projector, the one installed to your computer always 
start even if it is older version than the one installed to the projector.

	 If audio transfer capability and other features will not work, try uninstalling Image Express Utility Lite from your computer. This 
will allow you to use all the features.

•	 USB Display will not work in [NORMAL] of [STANDBY MODE]. To use USB Display, select [NETWORK STANDBY] for [STANDBY 
MODE]. (→ page 101)

•	 When USB Display is used, the sound is output from the COMPUTER AUDIO IN Mini Jack (Stereo Mini). Image and sound may 
not be synchronized. 

1.	 Start the computer.

2.	 Connect the projector’s power cord to the wall outlet and put the projector into standby condition.

•	 Open the projector’s lens cover.

3.	 Use the USB cable to connect the computer with the projector.

AC IN

USB-B

USB cable (not supplied)

To wall outlet
Power cord (supplied)

	 The message “The projector is in standby mode. Connect it?” will be displayed on the computer screen.

•	 The control window of Image Express Utility Lite will be displayed on the top of the screen.

NOTE: Depending on the computer setting, the “AutoPlay” window may be displayed when the 
computer detects the connection to the projector. If this happens, click the “Start USB Display” 
window.

4.	 Click “Yes”.

	 The projector will turn on and the message “The projector is getting ready. Please wait.” will be displayed on the 
computer screen. This message will disappear in a few seconds.
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5.	 Operate the control window.

(1)  (Source)	����� Selects an input source of the projector. 
(2)  (Picture)	���� Turns on or off AV-MUTE (Picture mute), and turns on or off FREEZE (Freeze a picture).
(3)  (Sound)	����� Turns on or off AV-MUTE (Sound mute), play the sound and turns up or down the volume.
(4)  (Others)	����� Uses “Update”, “HTTP Server”*, “Settings” and “Information”.

*	 The HTTP Server cannot be selected when a USB cable is connected.

(5)  (Exit)	���������� Exit Image Express Utility Lite. You can also turn off the projector at the same time.
(6)  (Help)	����������� Displays the help of Image Express Utility Lite.

(1) (2) (3) (4) (5)(6)
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❾ Controlling the Projector by Using an HTTP Browser
Overview
The HTTP Server function provides settings and operations for:
1.	 Setting for wired/wireless network (NETWORK SETTINGS)

	 To use wireless LAN connection, the optional USB Wireless LAN Unit is required. (→ page 124)

	 To use wired/wireless LAN connection, connect the projector to the computer with a commercially available LAN 
cable. (→ page 123)

2.	 Setting Alert Mail (ALERT MAIL)

	 When the projector is connected to a wired/wireless network, lamp replace time or error messages will be sent via 
e-mail.

3.	 Operating the projector

	 Power on/off, selecting input, volume control and picture adjustments are possible.

4.	 Setting PJLink PASSWORD and AMX BEACON

5.	 Allowing Image Express Utility Lite to be downloaded and copied to your USB memory

This device uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting 
method will vary depending on the version of browser. Please refer to the help files and the other information provided 
in your software.

Two ways of access to the HTTP server function are available:
•	 Start the Web browser on the computer via the network connected to the projector and enter the following 

URL :

	 http://<the projector’s IP address> /index.html

•	 Use Image Express Utility Lite contained on the supplied NEC Projector CD-ROM.

TIP: The factory setting IP address is [DHCP ON].

NOTE: 
•	 To use the projector in a network, consult with your network administrator about network settings.
•	 The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your net-
work.

	 Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in 
rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projec-
tor.

•	 If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web 
browser (or clear the cache).

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 123)
Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the 
setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set 
will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be 
reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
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Handling of the Address for Operation via a Browser
Regarding the actual address that is entered for the address or entered to the URL column when operation of the pro-
jector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the 
projector has been registered to the domain name server by a network administrator, or the host name corresponding 
to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: �When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network 
setting by specifying 
  http://pj.nec.co.jp/index.html 
for the address or the entry column of the URL.

Example 2: �When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by 
specifying 
  http://192.168.73.1/index.html 
for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
ON	������������������������� Power is switched on.
OFF	������������������������ Power is switched off.

VOLUME: This controls the volume of the projector.
▲	��������������������������� Increases the volume adjustment value.
▼	��������������������������� Decreases the volume adjustment value.

AV-MUTE: This controls the mute function of the projector.
PICTURE ON	���������� Mutes the video.
PICTURE OFF	��������� Cancels the video muting.
SOUND ON	������������ Mutes the audio.
SOUND OFF	����������� Cancels the audio muting.
ALL ON	������������������ Mutes each of the video, and audio functions.
ALL OFF	����������������� Cancels the muting of each of the video, and audio functions.
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PICTURE: Controls the video adjustment of the projector.
BRIGHTNESS ▲	���� Increases the brightness adjustment value.
BRIGHTNESS ▼	���� Decreases the brightness adjustment value.
CONTRAST ▲	�������� Increases the contrast adjustment value.
CONTRAST ▼	�������� Decreases the contrast adjustment value.
COLOR ▲	�������������� Increases the color adjustment value.
COLOR ▼	�������������� Decreases the color adjustment value.
HUE ▲	������������������� Increases the hue adjustment value.
HUE ▼	������������������� Decreases the hue adjustment value.
SHARPNESS ▲	����� Increases the sharpness adjustment value.
SHARPNESS ▼	����� Decreases the sharpness adjustment value.

•	 The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 
86)

SOURCE SELECT: This switches the input connector of the projector.
COMPUTER	����������� Switches to the COMPUTER IN connector.
HDMI 1	������������������ Switches to the HDMI 1 IN connector.
HDMI 2	������������������ Switches to the HDMI 2 IN connector.
VIDEO	�������������������� Switches to the VIDEO IN connector.
USB-A	�������������������� Switches to the data on the USB memory device.
LAN	������������������������ Switches to a LAN signal.
USB-B	�������������������� Switches to the USB-B Port.

PROJECTOR STATUS: This displays the condition of the projector.
LAMP LIFE REMAINING	�����Displays the remaining life of the lamp as a percentage.
LAMP HOURS USED	�����������Displays how many hours the lamp has been used.
ERROR STATUS	������������������Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
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NETWORK SETTINGS

• SETTINGS

WIRED or WIRELESS

SETTING Set for wired LAN or for wireless LAN.

APPLY Apply your settings to wired LAN or wireless LAN.

DHCP ON Automatically assign IP address, subnet mask, and gateway to the projector from your 
DHCP server.

DHCP OFF Set IP address, subnet mask, and gateway to the projector assigned by your network 
administrator.

IP ADDRESS Set your IP address of the network connected to the projector.

SUBNET MASK Set your subnet mask number of the network connected to the projector.

GATEWAY Set the default gateway of the network connected to the projector.

AUTO DNS ON DHCP server will automatically assign IP address of DNS server connected to the 
projector.

AUTO DNS OFF Set your IP address of DNS server connected to the projector.

Setting for WIRED LAN

ENABLE Turn on wired LAN connection

DISABLE Turn off wired LAN connection

Setting for WIRELESS LAN (with the optional USB Wireless LAN Unit equipped) 

EASY CONNECTION Execute a wireless LAN using EASY CONNECTION.

SIMPLE ACCESS POINT Set the projector for simple access point. 

CHANNEL Select a channel. Available channels vary depending on the country and region. When 
you select [INFRASTRUCTURE], make sure that the projector and your access point 
are on the same channel; when you select [AD HOC], make sure that the projector and 
your computer are on the same channel.

PROFILE 1/PROFILE 2 Two settings can be set for wireless LAN connection. Select PROFILE 1 or PROFILE 
2.

SSID Enter an identifier (SSID) for wireless LAN. Communication can be done only with 
equipment whose SSID matches SSID for your wireless LAN.

SITE SURVEY Displays a list of available SSIDs for wireless LAN on site. Select an SSID which you 
can access.
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NETWORK TYPE Select communication method when using wireless LAN.
INFRASTRUCTURE: Select this option when communicating with one or more equip-
ment connected to the wireless LAN network via a wireless access point.
AD HOC: Select this option when using the wireless LAN to directly communicate with 
a computer in peer-to-peer mode. 

SECURITY TYPE Turn on or off the encryption mode for secure transmission. When turn on the encryp-
tion mode, set WEP key or encrypted key.

DISABLE Will not turn on the encryption feature. Your communications 
may be monitored by someone.

WEP 64 bit Uses 64-bit datalength for secure transmission.

WEP 128 bit Uses 128-bit datalength for secure transmission. This option will 
increase privacy and security when compared to use of 64-bit 
datalength encryption.

WPA-PSK TKIP/
WPA-PSK AES/
WPA2-PSK TKIP/
WPA2-PSK AES/

These options provide stronger security 
than WEP.

NOTE:
•	 The WEP settings must be the same as communication devices such as PC or access point in 
your wireless network.

•	 When you use WEP, your image transmission speed will slow down.
•	 [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] and [WPA2 PSK-AES] are not available 
when [AD HOC] is selected from [NETWORK TYPE].

INDEX Select encryption key when selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY 
TYPE]. When [WEP 64bit] or [WEP 128bit] is selected for [SECURITY TYPE], the WEP 
key is fixed to “1” and cannot be changed.

KEY When selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE]:
Enter WEP key.

Select Characters (ASCII) Hexadecimal digit (HEX)

WEP 64 bit Up to 5 characters Up to 10 characters

WEP 128 bit Up to 13 characters Up to 26 characters

When selecting [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] or [WPA2 
PSK-AES]:
Enter encryption key. Key length must be 8 or greater and 63 or less.
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• NAME

PROJECTOR NAME Enter a name for your projector so that your computer can identify the projector. A 
projector name must be 16 characters or less. 
TIP: Projector name will not be affected even when [RESET] is done from the menu.

HOST NAME Enter the hostname of the network connected to the projector. A host name must be 
15 or less.

DOMAIN NAME Enter the domain name of the network connected to the projector. A domain name 
must be 60 characters or less.

• ALERT MAIL

ALERT MAIL (English 
only)

This option will notify your computer of lamp replace time or error messages via e-mail 
when using wireless or wired LAN. 
Placing a checkmark will turn on the Alert Mail feature.
Clearing a checkmark will turn off the Alert Mail feature.
Sample of a message to be sent from the projector:

The lamp is at the end of its usable life. Please replace the lamp.
Projector Name: NEC Projector
Lamp Hours Used: 100 [H]

SENDER’S ADDRESS Enter sender’s address. 

SMTP SERVER NAME Enter the SMTP server name to be connected to the projector.

RECIPIENT’S ADDRESS 
1,2,3

Enter your recipient’s address. Up to three addresses can be entered.

TEST MAIL Send a test mail to check whether your settings are correct or not
NOTE:
•	 If you execute a test, you may not receive an Alert mail. Should this happen, check if network 
settings are correct.

•	 If you entered an incorrect address in a test, you may not receive an Alert mail. Should this 
happen, check if the Recipient’s Address is correct.

SAVE Click this button to reflect the above settings.

• NETWORK SERVICE

PJLink PASSWORD Set a password for PJLink*. A password must be 32 characters or less. Do not forget 
your password. However, if you forget your password, consult with your dealer.

HTTP PASSWORD Set a password for HTTP server. A password must be 10 characters or less.

AMX BEACON Turn on or off for detection from AMX Device Discovery when connecting to the network 
supported by AMX’s NetLinx control system.
TIP: 
When using a device that supports AMX Device Discovery, all AMX NetLinx control system will rec-
ognize the device and download the appropriate Device Discovery Module from an AMX server.
Placing a checkmark will enable detecting the projector from AMX Device Discovery.
Clearing a checkmark will disable detecting the projector from AMX Device Discovery.

Image Express Utility Lite Click “DOWNLOAD” to display the download page from which the EXE file of Image 
Express Utility Lite can be downloaded to your USB memory connected to your com-
puter. (→ page 60)

SAVE Click this button to reflect the above settings.

*	 What is PJLink?
	 PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is estab-

lished by Japan Business Machine and Information System Industries Association (JBMIA) in 2005.
	 The projector supports all the commands of PJLink Class 1.
	 Setting of PJLink will not be affected even when [RESET] is done from the menu.



51

3. Convenient Features

CRESTRON ROOMVIEW compatibility
The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be managed 
and controlled from a computer or a controller.
For more information, visit http://www.crestron.com

<Setting Procedure>
Access to the HTTP server function, and make necessary settings for [CRESTRON] in [NETWORK SETTINGS].

• ROOMVIEW for managing from the computer.

DISABLE Disables ROOMVIEW.

ENABLE Enables ROOMVIEW.

• CRESTRON CONTROL for managing from the controller.

DISABLE Disables CRESTRON CONTROL.

ENABLE Enables CRESTRON CONTROL. 

IP ADDRESS Set your IP address of CRESTRON SERVER.

IP ID Set your IP ID of CRESTRON SERVER.

TIP: The CRESTRON settings are required only for use with CRESTRON ROOMVIEW.
For more information, visit http://www.crestron.com

• INFORMATION

WIRED LAN Display a list of settings of wired LAN connection.

WIRELESS LAN Display a list of settings of wireless LAN connection.

UPDATE Reflect settings when they are changed.

http://www.crestron.com
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❿ Controlling the Projector over a LAN (PC Control Utility Pro 4/
Pro 5)
Using the utility software “PC Control Utility Pro 4” and “PC Control Utility Pro 5” included on the companion NEC 
Projector CD-ROM, the projector can be controlled from a computer over a LAN.
PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 55)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event 
schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use 
PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 54, 55)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

•	 To run PC Control Utility Pro 4 on Windows 8 and Windows XP, “Microsoft .NET Framework Version 2.0” is required. 
The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install 
the it on your computer. 

TIP:
•	 PC Control Utility Pro 4 can be used with a serial connection.

Using on Windows

Step 1: Install PC Control Utility Pro 4 on the computer

NOTE:
•	 To install or uninstall the program, the Windows user account must have [Administrator] privilege (Windows 8, Windows 7, 
Windows Vista and Windows XP)

•	 Exit all running programs before installation. If another program is running, the installation may not be completed.

1	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.
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TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1.	 Click “start” on Windows.

2.	 Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 the menu window will be displayed.

2	 Click “PC Control Utility Pro 4” on the menu window.

	 The installation will start.

	 When the installation is complete, the Welcome window will be displayed.

3	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

	 Read “END USER LICENSE AGREEMENT” carefully.

4	 If you agree, click “I accept the terms in the license agreement” and then click “Next”.

•	 Follow the instructions on the installer screens to complete the installation.

•	 When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “PC Control Utility Pro 4” (→ page 39)
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Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 123), “Con-
necting to a Wireless LAN (Optional: NP02LM series)” (→ page 124) and “9. Controlling the Projector by Using an 
HTTP Browser” (→ page 45)

Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4”.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/
sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the 
scheduler.

[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer 
to sleep” → “Never”. 
NOTE: 
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/
wireless LAN) connection.

TIP:

Viewing the Help of PC Control Utility Pro 4
•	 Displaying the Help file of PC Control Utility Pro 4 while it is running.

	 Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.

	 The pop-up menu will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → 
“PC Control Utility Pro 4 Help”.

	 The Help screen will be displayed.
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Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer
1.	 Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.

	 The CD-ROM icon will be displayed on the desktop.

2.	 Double-click the CD-ROM icon.

	 The CD-ROM window will be displayed.

3.	 Double-click the “Mac OS X” folder.

4.	 Double-click “PC Control Utility.mpkg”.

	 The installer will start.

5.	 Click “Next”.

	 “END USER LICENSE AGREEMENT” screen will be displayed.

6.	 Read “END USER LICENSE AGREEMENT” and click “Next”.

	 The confirmation window will be displayed

7.	 Click “I accept the terms in the license agreement”.

	 Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 123), “Con-
necting to a Wireless LAN (Optional: NP02LM series)” (→ page 124) and “❾ Controlling the Projector by Using an 
HTTP Browser” (→ page 45)

Step 3: Start PC Control Utility Pro 5
1.	 Open your Applications folder in Mac OS.

2.	 Click the “PC Control Utility Pro 5” folder.

3.	 Click the “PC Control Utility Pro 5” icon.

	 PC Control Utility Pro 5 will start.

NOTE: 
•	 For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. 
Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.

•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/
wireless LAN) connection.

 
TIP:

Viewing the Help of PC Control Utility Pro 5
• Displaying the Help file of PC Control Utility Pro 5 while it is running. 
•	 From the menu bar, click “Help” → “Help” in this order. 

	 The Help screen will be displayed.

• Displaying the Help using the Dock 
1.	 Open “Application Folder” in Mac OS.

2.	 Click the “PC Control Utility Pro 5” folder.

3.	 Click the “PC Control Utility Pro 5 Help” icon.

	 The Help screen will be displayed.
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⓫ Projecting Your Computer’s Screen Image from the 
Projector over a LAN (Image Express Utility Lite)
 
Using Image Express Utility Lite contained on the supplied NEC Projector CD-ROM allows you to send the computer’s 
screen image and sound to the projector over a USB cable or a wired or wireless LAN.
Image Express Utility Lite is a program compatible with Windows.
Image Express Utility Lite for Mac OS is a program compatible with Mac OS. (→ page 61)
This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility 
Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

Step 1: install Image Express Utility Lite on the computer. 
Step 2: Connect the projector to a LAN.
Step 3: Start Image Express Utility Lite.

TIP:
•	 Image Express Utility Lite (for Windows) can be started from most commercially available removable media such as USB memory 
devices or SD cards without the need to install on your computer. (→ page 59)

What You can Do with Image Express Utility Lite

• Image transmission (for Windows and Mac OS)
•	 The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable 

(VGA).

•	 By using “EASY CONNECTION” function, the complicated network settings can be simplified and the computer 
will automatically connect to the projector.

•	 The screen of your computer can be sent to up to four projectors at the same time.

• Audio transfer capability (for Windows only)
•	 Image Express Utility Lite allows you to send the computer’s screen image and audio to the projector over wired/

wireless LAN or USB connection.

•	 Audio transfer capability is available only when the computer connects with the projector in peer-to-peer net-
work.

• USB Display (for Windows only)
•	 Computer’s screen image and audio can be projected via a USB cable, without connecting a computer cable 

(VGA).

•	 Just connecting the computer and the projector over a USB cable will make the USB Display function available 
(Plug & Play) even without installing Image Express Utility Lite on the computer. (→ page 43)

• Geometric Correction Tool [GCT] (for Windows only)
See “⓬ Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”.
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Using on Windows

Step 1: install Image Express Utility Lite on the computer. 

NOTE:
•	 To install or uninstall the program, the Windows user account must have “Administrator” privilege (Windows 8, Windows 7, 
Windows Vista and Windows XP). 

•	 Exit all running programs before installation. If another program is running, the installation may not be completed. 
•	 Image Express Utility Lite will be installed to the system drive of your computer.
	 If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the 
program.

1.	 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

	 The menu window will be displayed.

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. Click “start” on Windows.

2. Click “All Programs” → “Accessories” → “Run”.

3.	 Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE”   in “Name”. (example: Q:\
LAUNCHER.EXE)

4.	 Click “OK”.

	 The menu window will be displayed.

2.	 Click “Installing Image Express Utility Lite” on the menu window.

	 The installation will start.

	 “END USER LICENSE AGREEMENT” screen will be displayed. 

	 Read “END USER LICENSE AGREEMENT” carefully 

3.	 If you agree, click “I agree.” and then click “Next”. 

•	 Follow the instructions on the installer screens to complete the installation. 

•	 When the installation is complete, you will return to the menu window.

	 When the installation is complete, a completion message will be displayed.

4.	 Click “OK”.

	 This completes the installation.

TIP:
• Uninstalling Image Express Utility Lite
To uninstall Image Express Utility Lite, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote 
Tool” as “Image Express Utility Lite” (→ page 39)

Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 123), “Con-
necting to a Wireless LAN (Optional: NP02LM series)” (→ page 124) and “9. Controlling the Projector by Using an 
HTTP Browser” (→ page 45)
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Step 3: Start Image Express Utility Lite.
1.	 On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility 

Lite” → “Image Express Utility Lite”.

	 Image Express Utility Lite will start.

	 The select window for network connection will be displayed

2.	 Select Network and click “OK”.

	 The select window for destination will show a list of connectable projectors.

•	 When connecting the computer directly to the projector by one-to-one, “Easy Connection” is recommended.

•	 When one or more networks for “EASY CONNECTION” are found, the “Easy Connection Selection Screen” 
window will be displayed.

•	 To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS 
LAN] → [SSID].

3.	 Select the network you wish to connect, and click “Select”.

	 The target selection window will be displayed.

4.	 Place a check mark for projectors to be connected, and then click “Connect”.

•	 When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] 
→ [IP ADDRESS].

	 When connecting with the projector is established, you can operate the control window to control the projector. (→ 
page 44)

NOTE:
•	 When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed in the 
select window for destination

TIP:

Viewing the “Help” file of Image Express Utility Lite
•	 Displaying the Help file of Image Express Utility Lite while it is running.

	 Click the [?] (help) icon on the control window.

	 The Help screen will be displayed.

•	 Displaying the Help file of GCT while it is running.

	 Click “Help” → “Help” on the edit window.

	 The Help screen will be displayed.

•	 Displaying the help file using the Start Menu.

	 Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” 
→ “Image Express Utility Lite Help”.

	 The Help screen will be displayed.
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Starting Image Express Utility Lite from a USB Memory or SD Card
Image Express Utility Lite can be started from commercially available removable media such USB memory or SD cards 
if it is copied beforehand. This will eliminate the trouble of installing Image Express Utility Lite to your computer.
1.	 Copy Image Express Utility Lite to removable media.

	 Copy all the folders and files (total size approx. 6MB) from the “IEU_Lite (removable-media)” folder in the supplied 
NEC Projector CD-ROM to the root directory of your removable media.

2.	 Insert your removable media into your computer.

	 The “AutoPlay” screen will be displayed on your computer.

TIP: 
•	 If the “AutoPlay” screen is not displayed, open the folder from “Computer” (“My Computer” for Windows XP).

3.	 Click “Open folder to view files”

	 The IEU_Lite.exe, other folder, and files will be displayed.

4.	 Double-click the “IEU_Lite.exe” (  ) icon.

	 Image Express Utility Lite will start.

NOTE:
•	 The “EASY CONNECTION” function is not supported when Image Express Utility Lite is started from removable media.
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Downloading Image Express Utility Lite via the HTTP server
Downloading procedure when the projector is connected to the Internet.
1.	 Access the HTTP server. (→ page 45)

2.	 Select the “NETWORK SETTINGS” tab and then the “NETWORK SERVICE” tab.

3.	 Click “DOWNLOAD” for “Image Express Utility Lite”.

	 The download page will be displayed.

4.	 Place a checkmark for IEU_Lite (removable-media).zip and/or gct.ngm.

5.	 Click “DOWNLOAD”.

6.	 Choose a folder where you want to download the file and click “SAVE”. 

	 (A folder in your computer is recommeded.) 

	 The downloading will start.

	 After the downloading is completed, make sure that the file is placed in the destination folder.

Supported OS:
•	 Windows 8 (32-bit/64-bit)
•	 Windows 8 Pro (32-bit/64-bit)
•	 Windows 8 Enterprise (32-bit/64-bit)
•	 Windows 7 Home Basic (32-bit/64-bit)
•	 Windows 7 Home Premium (32-bit/64-bit)
•	 Windows 7 Professional (32-bit/64-bit)
•	 Windows 7 Ultimate (32-bit/64-bit)
•	 Windows 7 Enterprise (32-bit/64-bit)
•	 Windows Vista Home Basic (32-bit/64-bit)
•	 Windows Vista Home Premium (32-bit/64-bit)
•	 Windows Vista Business (32-bit/64-bit)
•	 Windows Vista Ultimate (32-bit/64-bit)
•	 Windows Vista Enterprise (32-bit/64-bit)
•	 Windows XP Home Edition Service Pack 3 or later (32-bit)
•	 Windows XP Professional Service Pack 3 or later (32-bit)

Starting IEU Lite (removable-media).zip and gct.ngm
1.	 Extract the downloaded IEU Lite (removable-media) zip file into your removable media.

2.	 Double-click the IEU Lite.exe icon in the IEU Lite (removable-media) folder.

•	 If you downloaded gct.ngm too, move gct.ngm to the same folder where IEU_Lite_GCT.exe is placed.

•	 To use the Geometric Correction Tool function (GCT) of Image Express Utility lite together with a video cable, 
double-click the “IEU_Lite_GCT.exe” icon. When GCT correction data (*.ngm) is saved in the same folder where 
IEU_Lite_GCT.exe is placed, the data will be automatically used without the need of LAN connection.

NOTE:
The “EASY CONNECTION” function is not supported when Image Express Utility Lite is started from removable media.
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Using on Mac OS

Step 1: Install Image Express Utility Lite for Mac OS on the computer
1.	 Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.

	 The CD-ROM icon will be displayed on the desktop.

2.	 Double-click the CD-ROM icon.

	 The CD-ROM window will be displayed.

3.	 Double-click the “Mac OS X” folder.

4.	 Double-click “Image Express Utility Lite.dmg”.

	 The “Image Express Utility Lite” window will be displayed.

5.	 Drag and drop the “Image Express Utility Lite” folder to your Applications folder in Mac OS.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 123), “Con-
necting to a Wireless LAN (Optional: NP02LM series)” (→ page 124) and “❾ Controlling the Projector by Using an 
HTTP Browser” (→ page 45)

Step 3: Start Image Express Utility Lite for Mac OS
1.	 Open your Applications folder in Mac OS.

2.	 Double-click the “Image Express Utility Lite” folder.

3.	 Double-click the “Image Express Utility Lite” icon.

	 When Image Express Utility Lite for Mac OS starts, the select window for destination will be displayed.

•	 At the first time of startup, “END USER LICENSE AGREEMENT” screen will be displayed before the select 
window for destination is displayed.

	 Read “END USER LICENSE AGREEMENT” and select “I accept the terms in the license agreement”, and click 
“OK”.

4.	 Select a projector to be connected, and then click “Connect”.

	 Your desktop screen will be displayed on the projector.
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TIP:
Viewing the Help of Image Express Utility Lite for Mac OS 
•	 From the menu bar, click “Help” → “Image Express Utility Lite Help” while Image Express Utility is run-

ning. 

	 The Help screen will be displayed
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⓬ Projecting an Image from an Angle (Geometric Correction 
Tool in Image Express Utility Lite)
 
The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected even from an 
angle. 

What you can do with GCT

•	 The GCT feature includes the following three functions

•	 4-point Correction: You can fit a projected image within the border of the screen easily by align the four corners 
of an image to the ones of the screen.

•	 Multi-point Correction: You can correct a distorted image on the corner of a wall or irregular shaped screen 
by using many separated screens to correct the image as well as 4-point Correction.

•	 Parameters Correction: You can correct a distorted image by using a combination of transformational rules 
prepared in advance.

This section will show an example for use with 4-point Correction.
For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express 
Utility Lite. (→ page 58) 

•	 Your correction data can be stored in the projector or your computer which can be restored when necessary.

•	 The GCT function is available with a USB cable, wired or wireless LAN connection, and video cable. 

Projecting an Image from an Angle (GCT)
This section will show an example for use with USB Display (using a USB cable to connect a computer and the pro-
jector).
•	 The USB Display function will automatically display the control window 

•	 For a video cable or LAN connection, install and start Image Express Utility Lite in your computer beforehand. (→ 
page 56)

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1.	 Click the “   ” (Picture) icon and then the “   ” button.

	 The “4-point Correction” window will be displayed.

2.	 Click the “Start Correction” button and then “Start 4-point Correction” button.

	 A green frame and a mouse pointer (   ) will be displayed.

•	 Four [ • ] marks will be appeared at four corners of the green frame
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3.	 Use the mouse to click the [ • ] mark of which corner you wish to move.

	 The currently selected [ • ] mark will turn red.

(In the above example, Windows screens are omitted for clarification.)

4.	 Drag the selected [ • ] mark to the point you wish to correct and drop it.

•	 When you click somewhere within the project image area, the nearest [ • ] mark will go to the position where 
the mouse cursor is.

5.	 Repeat Step 3 and 4 to correct the distortion of the projected image.

6.	 After completing, right-click the mouse.

	 The green frame and the mouse pointer will disappear from the projected image area. This will complete the cor-
rection.

7.	 Click the “X” (close) button on the “4-point Correction” window.

	 The “4-point Correction” window will disappear and the 4-point correction will take effect.

8.	 Click the “   ” button on the control window to exit the GCT.

TIP:
•	 After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Export to 
the projector…” on the “4-point Correction” window.

•	 See the Help of Image Express Utility Lite for operating “4-point Correction” window and other functions than GCT. (→ page 
58)



65

3. Convenient Features

⓭ Viewing 3D Images

The projector provides 3D images to a user wearing commercially available LCD shutter eyeglasses.

 CAUTION
Health precautions
Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your LCD 
shutter eyeglasses or your 3D compatible content such as DVDs, video games, computer’s video files and the like.
To avoid any adverse symptoms, heed the following:
•	 Do not use LCD shutter eyeglasses for viewing any material other than 3D images.
•	 Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a 

distance can strain your eyes.
•	 Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour 

of viewing.
•	 If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D 

images.
•	 While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry 

vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor. 
•	 View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain. 

LCD shutter eyeglasses (recommended)
•	 DLP Link compatible 3D eyeglasses manufactured by XPAND is recommended.

You can also use commercially available DLP® Link or other method compatible LCD shutter eyeglasses.

Steps for viewing 3D images on the projector
1.	 Connect the projector to your video equipment. 

2.	 Turn on the projector, display the on-screen menu, and then select [ON] for the 3D mode.

	 For the operating procedure to turn on the 3D mode, refer to “On-screen menu for 3D images” on the following 
page.

3.	 Play your 3D compatible content and use the projector to display the image.

4.	 Put on your LCD shutter eyeglasses to view 3D images.

	 Also refer to the user’s manual accompanied with your LCD shutter eyeglasses for more information.
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On-screen menu for 3D images
Follow the steps to display the 3D menu.
1.	 Press the MENU button. 

	 The on-screen menu will be displayed.

2.	 Press the ▷ button twice.

	 The [SETUP] menu will be displayed.

3.	 Press the ▽ button once, and then press the ▷ button five times.

	 The [3D] menu will be displayed

4.	 Press the ▽ button to select a signal and press the ENTER button.

	 The 3D (DETAIL SETTINGS) screen will be displayed.

5.	 Press the ▽ button to select [3D] and press the ENTER button.

6.	 Press the ▽ button to select [ON].

	 The selected signal will be displayed in 3D.

7. 	Press the ▽ button to [GLASSES] and press the ENTER button.

	 The [GLASSES] setting screen will be displayed.
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8.	 Press the ▽ button to select a compatible eyeglass method and press the ENTER button.

	 Set other 3D-related menu options such as [FORMAT] and [L/R INVERT] as necessary. 

9.	 Press the MENU button once.

	 The menu will disappear.

Selecting input connected to a source of 3D images [COMPUTER/HDMI1/HDMI2/VIDEO]
This function switches the 3D mode between ON and OFF for each input.

NOTE:
To confirm that the supported 3D signal is accepted, use either way of the following:
•	 Make sure that [3D] is displayed in the top right of the screen after the source is selected.
•	 Display [INFO.] → [SOURCE] → [3D SIGNAL] and make sure that “SUPPORTED” is displayed.

To view 3D images, see page 65.
Select [COMPUTER], [HDMI1], [HDMI2], or [VIDEO].

NOTE:
•	 The maximum distance for viewing 3D images is 10 m/394 inches from the screen surface under the following restrictions:

-	 Brightness on the projector: 2000 lumens or greater
-	 Screen gain: 1
-	 Viewing position: Facing straight towards the screen center
-	 Outside light: None
-	 LCD shutter eyeglasses: Using the optional 3D Goggles (NP02GL)

•	 If 3D content is played back on your computer and the performance is poor it may be caused by the CPU or graphics chip. In this 
case you may have difficulty seeing the 3D images as they were intended. Check to see if your computer meets the requirements 
provided in your user’s manual included with your 3D content.

•	 The DLP® Link compatible LCD shutter eyeglasses allow you to view 3D images by receiving synch signals, which are included 
in left eye and right eye images, reflected from the screen. Depending on environments or conditions such as the ambient bright-
ness, screen size or viewing distance, the LCD shutter eyeglasses may fail to receive synch signals, causing poor 3D images.

•	 When the 3D mode is enabled, the Keystone correction range will be narrower.
•	 When the 3D mode is enabled, the following settings are invalid.
	 [WALL COLOR], [PRESET], [REFERENCE], [COLOR TEMPERATURE]
•	 Refer to the [SOURCE] screen under the [INFO.] menu for information on whether the input signal is 3D compatible.
•	 Signals other than those listed in “Compatible Input Signal List” on page 138 will be out of range or will be displayed in 2D.
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Troubleshooting on viewing 3D images
If images will not be displayed in 3D or 3D images appear as 2D, check the following table. Also refer to the user’s 
manual accompanied with your 3D content or LCD shutter eyeglasses.

Possible causes Solutions
•	 The content you are playing back is not compatible with 3D. •	 Play back a content compatible with 3D.

•	 The 3D mode was turned off for the selected source.
•	 Use the projector’s menu to turn on 3D mode for the selected 

source. (→ page 104)
•	 You are not using our recommended LCD shutter eyeglasses. •	 Use our recommended LCD shutter eyeglasses. (→ page 65)
•	 If the shutter of your LCD shutter eyeglasses cannot synchronize 

with the currently projected source, the following are possible 
causes:
-	 Your LCD shutter eyeglasses are not switched on. •	 Switch on your LCD shutter eyeglasses.
-	 The battery in the LCD shutter eyeglasses ran down. •	 Recharge the battery or replace it.

-	 The correct eyeglass method is not selected. 
•	 Change the eyeglass method for 3D by using the menu.. (→ 

page 104)

-	 The viewing distance between the viewer and the screen is 
too far.

•	 Move closer to the screen until the viewer gets 3D images. 
•	 Or use the projector’s menu to select [NON-INVERT] for [L/R 

INVERT]. 

-	 There are bright light sources or other projectors near the 
viewer.

•	 Keep light sources or other projectors away from the viewer.
•	 Do not look toward a bright light source.
•	 Or use the projector’s menu to select [NON-INVERT] for [L/R 

INVERT]. 
•	 If your computer is not set for 3D viewing, the following are 

possible causes:
-	 Your computer does not meet the requirements for 3D view-

ing.
•	 Check to see if your computer meets the requirements provided 

in your user’s manual included with your 3D content.
-	 Your computer is not set for 3D output. •	 Set your computer for 3D output.
-	 The resolution of output signal is out of range. •	 Select the resolution of output signal supporting 3D. 
-	 The refresh rate of output signal is out of range. •	 Change the refresh rate to 60Hz or 120Hz. 
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⓮ Connecting Your Microphone
 
Connecting a commercially available dynamic or condenser microphone to the MIC input jack allows you to output 
your mic sound from the built-in speaker.

Sound from COMPUTER, HDMI 1, HDMI 2, and VIDEO audio inputs or sound of USB-A/LAN input will be heard from 
the speaker with your microphone voice. 
Type of microphone can be selected. From the menu, select [SETUP] → [INSTALLATION] → [MIC SELECT] (→ page 
99)
Microphone sensitivity can be adjusted. From the menu, select [SETUP] → [INSTALLATION] → [MIC GAIN]. (→ page 
99)

NOTE:
•	 The MIC input jack does not support plugin power microphones.
•	 If there is no signal when either HDMI input is selected, sound output may not work.

MIC
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❶ What you can do with the Viewer
The Viewer has the following features.

•	 When a commercially available USB memory that stores image files is inserted into the USB port (Type A) of the 
projector, the Viewer allows you to view the image files on the USB memory.

	 Even if no computer is available, presentations can be conducted simply with the projector. 

•	 Supported graphic format is JPEG.

•	 The Viewer displays the thumbnail screen (JPEG Exif only) on which you can jump to any specific image you wish 
to project.

•	 There are two ways of playback for slideshow: manual playback and auto playback. The interval time can be 
changed in auto playback.

•	 The order of displaying images can be set by name, date or size. Ascending or descending order can be se-
lected.

•	 Images can be rotated by 90 degrees during playback.
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NOTE
•	 The USB port of the projector does not support USB hub. 
•	 The following operations by using the buttons on the projector are not possible when the VIEWER screen such as the slide screen 
and the thumbnail screen is displayed.
-	 Keystone correction by using the ▲/▼ button
-	 Auto Adjustment by using the AUTO ADJ. button
-	 Volume control with the ◀ or ▶ button
	 To perform Keystone correction or Source selection during display of the Viewer, press the MENU button twice to display the 
menu and operate Viewer from the menu.

•	 Freezing picture by using the FREEZE button on the remote control is not possible when the VIEWER screen such as the slide 
screen and the thumbnail screen is displayed.

•	 Executing [RESET] → [ALL DATA] from the menu will return the settings for the Viewer toolbar to the factory default.
•	 USB memory
-	 Be sure to use a USB memory device formatted with the FAT32 or FAT16 file system. 
	 The projector does not support NTFS formatted USB memory.
	 If the projector does not recognize your USB memory, check if the format is supported.
	 To format your USB memory in your computer, refer to the document or help file that comes with your Windows.
-	 We do not warrant that the USB port of the projector will support all USB memories in the market.

•	 Supported images
-	 Supported file format for Viewer are as follows.
	 We do not warrant all the images are supported for Viewer.
	 Images other than mentioned in the table may not be supported.

Image type Extension Description

JPEG JPG/JPEG Baseline/Exif are supported

-	 Slideshow, effect, and sound effect set with PowerPoint cannot be played back.
-	 Image can be displayed at a resolution up to 10000 × 10000 pixels.
-	 Even if images are met by the above conditions, there may be some images which cannot be played back.
-	 More than 200 icons (total number of image file icons and folder icons) cannot be displayed in a thumbnail screen.
-	 Long file/folder name will be limited to the specified length. This can be shown by bracket added.
-	 If one folder has many files, it takes some time to play back.

•	 If a single folder contains too many files, switching images will take time. To shorten switching time, reduce the number of images 
contained in a single folder.

TIP: Exchangeable image file format (Exif) is a standard image file format used by digital cameras with the addition of specific 
shooting data.
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❷ Projecting images stored in a USB memory device
This section explains the basic operation of the Viewer. 
The explanation provides the operational procedure when the Viewer toolbar (→ page 76) is set to the factory de-
fault.

• Starting the Viewer........................................................................below
• Removing the USB memory from the projector........................ page 74
• Exiting the Viewer..................................................................... page 74

Preparation: Before starting the Viewer, store images to the USB memory using your computer.

Starting the Viewer
1.	 Turn on the projector. (→ page 17)

2.	 Insert the USB memory into the USB port of the projec-
tor.

•	 Do not remove the USB memory from the projector while 
it’s LED flashes. Doing so may corrupt the data.

3.	 Press the SOURCE button on the projector cabinet.

	 The Viewer start screen will be displayed.

•	 Press the USB-A button on the remote control.



73

4. Using the Viewer

4.	 Press the ENTER button.

	 The thumbnail screen will be displayed. (→ page 75)

5.	 Use the ▲▼◀ or ▶ button to select an icon.

•	 The → (arrow) symbol on the right indicates there are more 
pages. pressing the PAGE ▽ (page down) button will show 
the next page: pressing the PAGE △ (page up) will show 
the previous page.

6.	 Press the ENTER button.

	 The selected slide will be displayed.

•	 When a folder icon is selected, icons contained in the folder 
will be displayed.

7.	 Press the ▶ button to select the next slide.

	 The slide on the right will be displayed.

•	 The ◀ or ▶ button can be used to select the next (right) 
slide or the previous (left) slide in the thumbnail screen.

•	 Pressing the MENU button during display of the thumbnail 
screen, the slide screen, or the slideshow screen will display 
the toolbar. The toolbar is used to select or rotate an slide.
(→ page 76)

8.	 Press the EXIT button when the toolbar is not dis-
played.

	 The thumbnail screen will be displayed.

•	 Another way to display the thumbnail screen is to press the 
ENTER button.

•	 To close the toolbar, press the MENU button to return to the 
SOURCE list, and press the MENU button again to close 
the SOURCE list.
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Removing the USB memory from the projector
1.	 Select the VIEWER start screen.

	 Press the EXIT button with no menu displayed.

2.	 Remove the USB memory from the projector.

	 Make sure that the LED on the USB memory is not flashing 
before removing the USB memory.

NOTE: If you remove the USB memory from the projector with a slide 
displayed, the projector may not operate correctly. If this happens, 
turn off the projector and unplug the power cord. Wait 3 minutes, then 
connect the power cord, and turn on the projector.

Exiting the Viewer
1.	 Press the MENU button with the slide screen or the 

thumbnail screen displayed.

	 The control bar or the pop-up menu will be displayed.

2.	  Press the MENU button again.

	 The on-screen menu will be displayed.

3.	 Select a source other than [USB-A] and press the EN-
TER button.

	 The Viewer will be exited.

TIP: To exit the Viewer using the remote control, select a source other 
than [USB-A].
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Parts of each screen
The Viewer has four screens.

(1) Viewer start screen (3) Thumbnail screen (9) Slide screen/
(11) Slideshow screen

Name Description

(1) Viewer start screen This screen will be displayed first when you select the Viewer.

(2) USB icon This icon indicates that the USB memory is inserted into the projector.

(3) Thumbnail screen This screen will show a list of folders and image files stored in the USB memory. The 
JPEG Exif files will be displayed in thumbnail screen only.
•	 The maximum number of image files or folders within one page is different depending 

on the model.
	 M332XS are 5 by 4
	 M352WS/M302WS are 6 by 4

(4) Cursor The cursor is used to select (highlight) the folder or image file by using ▲▼◀▶ but-
ton.

(5) Back icon This icon is used to return to the upper (parent) folder.

(6) Folder icon This icon shows that the USB memory has folders.

(7) �Page up (Page down) 
icon

This icon shows further folders or image files are available in the next (previous) page. 
Use the ▶ button to go to the next (previous) row. The PAGE ▽ or PAGE △ on the 
remote control is used to go to the next or previous page directly.

(8) Thumbnail toolbar This toolbar is used in the thumbnail screen. Pressing the MENU button will display 
this toolbar. (→ page 76)

(9) Slide screen This screen is used for manual playback. The selected image will be displayed in full 
screen.

(10) Slide toolbar This toolbar is used in the slide screen. Pressing the MENU button will display this 
toolbar. (→ page 77)

(11) Slideshow screen This screen is used for auto playback. The slides will be changed automatically.

(12) Slideshow toolbar This toolbar is used in the slideshow screen. Pressing the MENU button will display 
this toolbar. (→ page 77)

(5) (6) (4) (7)

(8)(2) (10) (12)
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Using the toolbar

1.	 Press the MENU button.

	 The toolbar will be displayed.

	 The SOURCE screen will be displayed as Viewer connection screen.

2.	 Use the ◀ or ▶ button to select an item and use the ▲ or ▼ button to select its available option.

	 When the cursor is placed, the selected item will be changed to yellow.

	 The ▲ or ▼ shows more available choices.

3.	 Press the ENTER button.

	 The selected item will be displayed.

4.	 Press the MENU button two times.

	 The toolbar will be closed and the SOURCE list will be displayed. Press the MENU button again to close the 
SOURCE list.

Thumbnail toolbar

Menu Options Description

(1) Back — Goes back to the previous image. When the cursor reaches the top left of 
the screen, it will go to the previous page.

(2) Forward — Goes to the next image. When the cursor reaches the bottom right of the 
screen, it will go to the next page.

(3) Display Closes the menu and returns to the thumbnail screen.

Closes the menu and starts the slideshow from the highlighted item.

Closes the menu and displays the slide screen.

(4) Order Displays the icons alphabetically by name. (number before alphabet)

Displays the icons in descending order of file size.

Displays the icons in the order of creation date

(1) (2) (3) (4)
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Slide toolbar

Menu Options Description

(1) Display Closes the menu and switches to the slide screen.

Closes the menu and displays the thumbnail screen.

Closes the menu and starts the slideshow from the highlighted item.

(2) �Image 
display

Closes the menu and displays the image in its actual size.

Closes the menu and displays the image in the projector’s maximum reso-
lution.

(3) �Clockwise 
rotation

— Close the menu and rotate the image 90°clockwise

(4) �Counter-
clockwise 
rotation

— Close the menu and rotate the image 90°counter clockwise

Slideshow toolbar

Menu Options Description

(1) Stop — Closes the menu and changes to the slide screen.

(2) Back — Goes back to the previous image.

(3) Forward — Goes to the next image.

(4) Interval Specifies interval time when playing back the slides.

(5) Repeat Repeats to play back the images in the folder.

Returns to the thumbnail screen.

TIP:
•	 A picture icon at the center of the screen shows that the file cannot be displayed in the slide screen or thumbnail screen.
•	 Slide toolbar setting for rotation will be cancelled if the folder is moved from one place to another.

(1) (2) (3) (4)

(1) (2) (3) (4) (5)
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❶ Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1.	 Press the MENU button on the remote control or the projector cabinet to display the menu.

NOTE: The commands such as ENTER, EXIT, ▲▼, ◀▶ in the bottom show available buttons for your operation.

2.	 Press the ◀▶ buttons on the remote control or the projector cabinet to display the submenu.

3.	 Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first 
tab.

4.	 Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or 
set.

	 You can use the ◀▶ buttons on the remote control or the projector cabinet to select the tab you want.

5.	 Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6.	 Adjust the level or turn the selected item on or off by using the ▲▼◀▶ buttons on the remote control or 
the projector cabinet.

Changes are stored until adjusted again.

7.	 Repeat steps 2 -6 to adjust an additional item, or press the EXIT button on the remote control or the projec-
tor cabinet to quit the menu display.

NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8. 	Press the MENU button to close the menu.

	 To return to the previous menu, press the EXIT button.
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❷ Menu Elements
Slide bar

Solid triangle

Tab

Radio button

High Altitude symbol

ECO mode symbol

Wireless symbol

Menu windows or dialog boxes typically have the following elements:

Highlight	����������������������������� Indicates the selected menu or item. 
Solid triangle	���������������������� Indicates further choices are available. A highlighted triangle indicates the item is active. 
Tab	�������������������������������������� Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
Radio button	�����������������������Use this round button to select an option in a dialog box.
Source	�������������������������������� Indicates the currently selected source.
Off Timer remaining time	���� Indicates the remaining countdown time when the [OFF TIMER] is preset.
Slide bar	����������������������������� Indicates settings or the direction of adjustment.
ECO mode symbol	�������������� Indicates ECO MODE is set.
Key Lock symbol	���������������� Indicates the [CONTROL PANEL LOCK] is enabled.
Thermometer symbol	��������� Indicates the [ECO MODE] is forcibly set to [ON] mode because the internal temperature is too 

high.
High Altitude symbol	���������� Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
Wireless symbol	����������������� Indicate the wireless LAN connection is enabled.

Source

Available buttons

Thermometer symbol

Key Lock symbol

Off Timer remaining 
time

Highlight
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❸ List of Menu Items
Some menu items are not available depending on the input source.
Menu Item Default Options

SOURCE

COMPUTER *

HDMI1 *

HDMI2 *

VIDEO *

USB-A *

LAN *

USB-B *

ADJUST

PICTURE

PRESET * 1–7

DETAIL 
SETTINGS

REFERENCE * HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, 
sRGB, DICOM SIM.

GAMMA 
CORRECTION*1 DYNAMIC, NATURAL, BLACK DETAIL

SCREEN SIZE*2 * LARGE, MEDIUM, SMALL
COLOR 
TEMPERATURE * 5000, 6500, 7800, 9300

COLOR 
ENHANCEMENT * OFF, LOW, MEDIUM, HIGH

DYNAMIC 
CONTRAST * OFF, ON

CONTRAST 64

BRIGHTNESS 64

SHARPNESS 8

COLOR 64

HUE 32

RESET

IMAGE 
OPTIONS

CLOCK *

PHASE *

HORIZONTAL *

VERTICAL *
OVERSCAN AUTO AUTO, OFF, ON

ASPECT RATIO
* M332XS: AUTO, 4:3, 16:9, 15:9, 16:10, WIDE ZOOM, NATIVE

* M352WS/M302WS: AUTO, 4:3, 16:9, 15:9, 16:10, 
LETTERBOX, NATIVE

POSITION (Not available on M352WS/
M302WS) 0 −16 to 16

NOISE REDUCTION OFF OFF, LOW, MEDIUM, HIGH
TELECINE 2-2/2-3 AUTO OFF, 2-2/2-3 AUTO, 2-2 ON, 2-3 ON

SETUP GENERAL

DIGITAL ZOOM 100 80 to 100
AUTO KEYSTONE ON OFF, ON
KEYSTONE 0 −30 to 30
KEYSTONE SAVE OFF OFF, ON

WALL COLOR OFF OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD 
(GRAY), LIGHT YELLOW, LIGHT BLUE, LIGHT ROSE

ECO SETTINGS

ECO MODE AUTO ECO OFF, AUTO ECO, NORMAL, ECO
AUTO ECO 
OPTIONS
AUTO DIM OFF OFF, 0:01, 0:03, 0:10, 0:20
ROOM LIGHT 
SENSING OFF OFF, ON

NORMAL OPTION
CONSTANT 
BRIGHTNESS OFF OFF, ON

ECO OPTION
CONSTANT 
BRIGHTNESS OFF OFF, ON

CLOSED CAPTION OFF OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, 
TEXT1, TEXT2, TEXT3, TEXT4

OFF TIMER OFF OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00

LANGUAGE ENGLISH

ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, 
SVENSKA, 日本語
DANSK, PORTUGUÊS, ČEŠTINA, MAGYAR, POLSKI, 
NEDERLANDS, SUOMI
NORSK, TÜRKÇE, РУССКИЙ, , Ελληνικά, 中文, 한국어
ROMÂNĂ, HRVATSKI, БЪЛГАРСКИ, INDONESIA, हिन्दी, 
ไทย, , 繁體中文

*	 The asterisk (*) indicates that the default setting varies depending on the signal.
*1	 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].
*2	 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
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Menu Item Default Options

SETUP

MENU

COLOR SELECT COLOR COLOR, MONOCHROME
SOURCE DISPLAY ON OFF, ON
ID DISPLAY ON OFF, ON
ECO MESSAGE OFF OFF, ON
DISPLAY TIME AUTO 45 SEC MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC
BACKGROUND BLUE BLUE, BLACK, LOGO

INSTALLATION

ORIENTATION DESKTOP 
FRONT

DESKTOP FRONT, CEILING REAR, DESKTOP REAR, 
CEILING FRONT

CONTROL PANEL LOCK OFF OFF, ON
SECURITY OFF OFF, ON
COMMUNICATION SPEED 38400bps 4800bps, 9600bps, 19200bps, 38400bps

CONTROL ID
CONTROL ID 
NUMBER 1 1 to 254

CONTROL ID OFF OFF, ON
TEST PATTERN CROSS HATCH
MIC SELECT DYNAMIC MIC DYNAMIC MIC, CONDENSER MIC
MIC GAIN 2 0 to 15

OPTIONS(1)

FAN MODE AUTO AUTO, HIGH, HIGH ALTITUDE

COLOR SYSTEM VIDEO AUTO AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, 
SECAM

WXGA MODE
M332XS: OFF 

M352WS/
M302WS: ON

OFF, ON

HDMI SETTINGS

HDMI1
VIDEO LEVEL NORMAL AUTO, NORMAL, ENHANCED

HDMI2
VIDEO LEVEL NORMAL AUTO, NORMAL, ENHANCED

AUDIO SELECT

HDMI1 HDMI1 HDMI1, COMPUTER
HDMI2 HDMI2 HDMI2, COMPUTER
LAN LAN LAN, COMPUTER
USB B USB B USB B, COMPUTER

BEEP ON OFF, ON

OPTIONS(2)

STANDBY MODE NORMAL NORMAL, NETWORK STANDBY
DIRECT POWER ON OFF OFF, ON
AUTO POWER ON(COMP.) OFF OFF, ON
AUTO POWER OFF* 1:00 OFF, 0:05, 0:10, 0:15, 0:20, 0:30, 1:00

DEFAULT SOURCE SELECT LAST LAST, AUTO, COMPUTER, HDMI1, HDMI2, VIDEO, USB-A, 
LAN, USB-B

CARBON CONVERT 0.505
CURRENCY $ $, €, JP¥, RMB¥
CURRENCY CONVERT

3D

COMPUTER

3D OFF OFF, ON
GLASSES DLP® Link DLP® Link, OTHERS
FORMAT SIDE BY SIDE SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL
L/R INVERT NON-INVERT NON-INVERT, INVERT

HDMI1

3D OFF OFF, ON
GLASSES DLP® Link DLP® Link, OTHERS

FORMAT AUTO AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND 
BOTTOM

L/R INVERT NON-INVERT NON-INVERT, INVERT

HDMI2

3D OFF OFF, ON
GLASSES DLP® Link DLP® Link, OTHERS

FORMAT AUTO AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND 
BOTTOM

L/R INVERT NON-INVERT NON-INVERT, INVERT

VIDEO
3D OFF OFF, ON
GLASSES DLP® Link DLP® Link, OTHERS
L/R INVERT NON-INVERT NON-INVERT, INVERT

WIRED LAN

WIRED LAN ENABLE DISABLE, ENABLE

SETTINGS DHCP: ON
AUTO DNS: OFF

DHCP, IP ADDRESS, SUBNET MASK, GATEWAY, 
AUTO DNS, DNS

RECONNECT

WIRELESS LAN
PROFILE DISABLE DISABLE, EASY CONNECTION, SIMPLE ACCESS POINT, 

PROFILE1, PROFILE2
RECONNECT

*AUTO POWER OFF: This item can be selected only when [NORMAL] is selected for [STANDBY MODE].
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Menu Item Default Options

INFO.

USAGE TIME

LAMP LIFE REMAINING

LAMP HOURS USED

TOTAL CARBON SAVINGS

TOTAL COST SAVINGS

SOURCE(1)

RESOLUTION

HORIZONTAL FREQUENCY

VERTICAL FREQUENCY

SYNC TYPE

SYNC POLARITY

SCAN TYPE

SOURCE(2)

SIGNAL TYPE

VIDEO TYPE

BIT DEPTH

VIDEO LEVEL

3D SIGNAL

WIRED LAN

IP ADDRESS

SUBNET MASK

GATEWAY

MAC ADDRESS

WIRELESS LAN

IP ADDRESS

SUBNET MASK

GATEWAY

MAC ADDRESS

SSID

NETWORK TYPE

WEP/WPA

CHANNEL

SIGNAL LEVEL

VERSION(1)
FIRMWARE

DATA

VERSION(2) FIRMWARE2

OTHERS

PROJECTOR NAME

MODEL NO.

SERIAL NUMBER

LAN UNIT TYPE
CONTROL ID (when [CONTROL ID] 
is set)

RESET

CURRENT SIGNAL

ALL DATA

CLEAR LAMP HOURS
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❹ Menu Descriptions & Functions [SOURCE]

COMPUTER
Selects the computer connected to your COMPUTER input connector signal.
NOTE: When the component input signal is connected to the COMPUTER IN connector, select [COMPUTER] respectively.
 

HDMI1 and 2
Selects the HDMI compatible equipment connected to your HDMI 1 or HDMI 2 IN connector.

VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

USB-A (Viewer)
This feature enables you to make presentations using a USB memory that contains slides.
(→ page 70 “4. Using the Viewer”)

LAN
Selects a signal from the LAN port (RJ-45) or the installed USB wireless LAN unit (optional).

USB-B (USB Display)
Selects the computer connected to the USB-B port (type B) by using a commercially available USB cable. 
(→ page 43)
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❺ Menu Descriptions & Functions [ADJUST]
[PICTURE]

[PRESET]
This function allows you to select optimized settings for your projected image.
You can adjust neutral tint for yellow, cyan or magenta. 
There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set 
user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 7].

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values
DICOM SIM.	���������� Recommended for DICOM simulation format.

NOTE: 
•	 The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
•	 DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiol-
ogy (ACR) and the National Electrical Manufacturers Association (NEMA). 

	 The standard specifies how digital image data can be moved from system to system. 

[DETAIL SETTINGS]
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Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION], [SCREEN SIZE], [COLOR 
TEMPERATURE], [COLOR ENHANCEMENT], and [DYNAMIC CONTRAST]. 

HIGH-BRIGHT	�������� Recommended for use in a brightly lit room.
PRESENTATION	����� Recommended for making a presentation using a PowerPoint file.
VIDEO	�������������������� Recommended for typical TV program viewing.
MOVIE	������������������� Recommended for movies.
GRAPHIC	��������������� Recommended for graphics.
sRGB	��������������������� Standard color values.
DICOM SIM.	���������� Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:

DYNAMIC	�������������� Creates a high-contrast picture.
NATURAL	��������������� Natural reproduction of the picture.
BLACK DETAIL	������� Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.

LARGE	������������������� For screen size of 150"
MEDIUM	���������������� For screen size of 100"
SMALL	������������������� For screen size of 50"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Enhancing the Color [COLOR ENHANCEMENT]
This function allows you to adjust the color density of the image.
The color of the image will become deeper in the order of “LOW”, “MEDIUM” and “HIGH” as the image will become 
darker.
With [OFF] selected, the COLOR ENHANCEMENT function will not work.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically using the built-in iris.
To increase the contrast ratio, select [ON].

NOTE:
•	 The [DYNMIC CONTRAST] item cannot be selected in the following cases:
-	 When [CONSTANT BRIGHTNESS] is enabled with [ON] selected for [ECO MODE] from [ECO SETTINGS].
-	 When [ON] is selected for [3D] while images are projected.
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[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/− green to +/− blue. The red level is used as reference.

Input signal CONTRAST BRIGHTNESS SHARPNESS COLOR HUE

COMPUTER/HDMI (RGB) Yes Yes Yes No No

COMPUTER/HDMI (COMPONENT) Yes Yes Yes Yes Yes

VIDEO/COMPONENT Yes Yes Yes Yes Yes

USB-A/LAN/USB-B Yes Yes Yes No No

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; 
Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected 
will not be reset.
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[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK	������������������� Use this item to fine tune the computer image or to remove any vertical banding that might appear. This 
function adjusts the clock frequencies that eliminate the horizontal banding in the image.
This adjustment may be necessary when you connect your computer for the first time.

PHASE	������������������� Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is 
evident when part of your image appears to be shimmering.)
Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
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Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

NOTE: The [HORIZONTAL] and [VERTICAL] items are not available for VIDEO, HDMI1, HDMI2, USB-A, LAN, and USB-B.

-	 An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.

-	 The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the 
current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, 
its adjustments will be called up and applied.

	 To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] or [ALL 
DATA] and reset the adjustments.

Selecting Overscan Percentage [OVERSCAN]
This allows you to set the appropriate overscan for an incoming signal.

AUTO	��������������������� Display an appropriately overscanned image (factory setting).
OFF	������������������������ Does not overscan the image.
ON	������������������������� Overscans the image.

NOTE: 
•	 The [OVERSCAN] item cannot be selected when VIDEO signals are used or when [NATIVE] is selected for [ASPECT RATIO].
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Selecting Aspect Ratio [ASPECT RATIO]
The term “aspect ratio” refers to the ratio of width to height of a projected image.
The projector automatically determines the incoming signal and displays it in its appropriate aspect ratio.
• This table shows typical resolutions and aspect ratios that most computers support.

Resolution Aspect Ratio
VGA 640 × 480 4:3
SVGA 800 × 600 4:3
XGA 1024 × 768 4:3
WXGA 1280 × 768 15:9
WXGA 1280 × 800 16:10
WXGA+ 1440 × 900 16:10
SXGA 1280 × 1024 5:4
SXGA+ 1400 × 1050 4:3
UXGA 1600 × 1200 4:3
WUXGA 1920 × 1200 16:10

Options Function

AUTO The projector will automatically determine the incoming signal and display it in its aspect 
ratio. (→ next page)
The projector may erroneously determine the aspect ratio depending on its signal. If this 
occurs, select the appropriate aspect ratio from the following.

4:3 The image is displayed in 4:3 aspect ratio.

16:9 The image is displayed in 16:9 aspect ratio.

15:9 The image is displayed in 15:9 aspect ratio.

16:10 The image is displayed in 16:10 aspect ratio.

WIDE ZOOM
(M332XS)

The image is stretched left and right. 
Parts of the displayed image are cropped at the left and right edges and therefore not 
visible.

LETTERBOX
(M352WS/M302WS)

The image of a letterbox signal is stretched equally in the horizontal and vertical direc-
tions to fit the screen. Parts of the displayed image are cropped at the top and bottom 
edges and therefore not visible.

NATIVE The projector displays the current image in its true resolution when the incoming computer 
signal has a lower resolution than the projector’s native resolution.

[Example 1] When the incoming 
signal with the resolution of 800 × 
600 is displayed on the M332XS:

[Example 2] When the incoming 
signal with the resolution of 800 × 
600 is displayed on the M352WS/
M302WS:

NOTE:
•	 When a non-computer signal is displayed, the [NATIVE] is not available.
•	 When a signal with a higher resolution than the projector’s native resolution is displayed, [NA-
TIVE] is not available.
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Sample image when the appropriate aspect ratio is automatically determined
M332XS
[Computer signal]
Aspect ratio of incoming signal 4:3 5:4 16:9 15:9 16:10

Sample image when the appro-
priate aspect ratio is automati-
cally determined

[Video signal]
Aspect ratio of incoming signal 4:3 Letterbox Squeeze

Sample image when the as-
pect ratio is automatically de-
termined

NOTE: To display a squeezed signal prop-
erly, select [16:9] or [WIDE ZOOM].

M352WS/M302WS
[Computer signal]
Aspect ratio of incoming signal 4:3 5:4 16:9 15:9 16:10

Sample image when the appro-
priate aspect ratio is automati-
cally determined

[Video signal]
Aspect ratio of incoming signal 4:3 Letterbox Squeeze

Sample image when the as-
pect ratio is automatically de-
termined

NOTE: To display a letterbox signal prop-
erly, select [LETTERBOX].

NOTE: To display a squeezed signal prop-
erly, select [16:9].

TIP:
•	 Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
•	 The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect 
ratio for a video source.

	 The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
•	 The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

Adjusting the Vertical Position of Image [POSITION] (not available on M352WS/M302WS)
(only when [16:9], [15:9], or [16:10] is selected for [ASPECT RATIO])

When [16:9], [15:9], or [16:10] is selected in [ASPECT RATIO], the image is displayed with black borders on the top 
and bottom.
You can adjust the vertical position from the top to the bottom of the black area.
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Turning on Noise Reduction [NOISE REDUCTION]
This function allows you to select the level of noise reduction.
The projector is set to the optimized level for each signal at the factory.
Select your preference item for your signal when video noise is noticeable.
The options are [OFF], [LOW], [MEDIUM], and [HIGH].

NOTE: This feature is not available for the RGB signal. Noise reduction set to off gives best image quality by way of higher bandwidth. 
Noise reduction set to on softens the image.

Setting Telecine Mode [TELECINE]
This function allows you to convert motion picture film images into video. The process adds additional frames to the 
picture in order to increase the frame rate.

NOTE: This feature is available only when an SDTV signal is selected.

OFF	������������������������ Turns off the TELECINE mode.
2-2/2-3 AUTO	�������� Detects pull-down correction method.
2-2 ON	������������������� Uses 2-2 pull-down correction method
2-3 ON	������������������� Uses 2-3 pull-down correction method
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❻ Menu Descriptions & Functions [SETUP]

[GENERAL]

Using Digital Zoom [DIGITAL ZOOM]
This feature allows you to electronically fine adjust the image size on the screen. Use the ◀ or ▶ button to large or 
reduce the projected image. 

TIP: To adjust the projected image size roughly, move the projector away or closer to the screen. To fine adjust the zoom, use the 
[DIGITAL ZOOM] function. (→ page 22)

Enabling Auto Keystone [AUTO KEYSTONE]
This feature allows the projector to detect its tilt and correct vertical distortion automatically.
To turn on the AUTO KEYSTONE feature, select [ON]. To adjust the KEYSTONE feature manually, select [OFF].

Correcting Vertical Keystone Distortion Manually [KEYSTONE]
You can correct vertical distortion manually. (→ page 24)

TIP: When this option is highlighted, pressing the ENTER button will display its slide bar for adjustment.

Saving Vertical Keystone Correction [KEYSTONE SAVE]
This option enables you to save your current keystone settings.

OFF	������������������������ Does not save current keystone correction settings. It will return your keystone correction settings to 
“zero”.

ON	������������������������� Saves current keystone correction settings

Saving your change once affects all sources. The changes are saved when the projector is turned off.

NOTE: When [AUTO KEYSTONE] is set to [ON], [KEYSTONE SAVE] is not available. Next time you turn on the power, the AUTO 
KEYSTONE function will work and the data stored with [KEYSTONE SAVE] will be invalid.
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Using the Wall Color Correction [WALL COLOR]

	

This function allows for quick adaptive color correction in applications where the screen material is not white.

NOTE:
•	 Selecting [WHITEBOARD] reduces lamp brightness.
•	 The [WALL COLOR] item cannot be selected when [ON] is selected for [3D] while images are projected.

Setting various items related to lamp brightness [ECO SETTINGS]
This option allows you to decrease the power consumption or to prolong the lamp life by controlling the lamp bright-
ness.

ECO MODE
The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO2 emissions. Four 
brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes. (→ page 31)

NOTE: The [OFF] item is automatically selected for [ECO MODE] when [ON] is selected [3D] while images are projected.

AUTO ECO OPTIONS
Set options when [AUTO ECO] is selected for [ECO MODE].

AUTO DIM OFF The AUTO DIM feature will not work.

0:01, 0:03, 0:10, 0:20 
(min.)

This option will automatically dim the lamp light when 
no input signal is present for a certain period time: 0:01, 
0:03, 0:10, and 0:20 (minutes). When it reaches the pre-
set time, the lamp brightness will decrease to about 30% 
immediately after the screen becomes dim for a moment. 
Changing images will return to its original brightness.

ROOM LIGHT SENSING OFF The sensor will not work.

ON The sensor will detect ambient brightness and control the 
lamp brightness. If the projector is placed in a dark room, 
the lamp brightness will automatically decrease.
NOTE: The brightness cannot be changed when [CEILING REAR] 
or [CEILING FRONT] is selected for [ORIENTATION].

NORMAL OPTION
Set the option when [NORMAL] is selected for [ECO MODE].
CONSTANT BRIGHTNESS: 

OFF	������������������������ The CONSTANT BRIGHTNESS feature will not work. The lamp brightness will gradually decrease over long 
periods of time. 

ON	������������������������� The lamp brightness will increase according to the lamp use of time and will be kept at the lamp brightness 
equivalent to the brightness at NORMAL. After the lamp brightness reaches the maximum, the lamp bright-
ness will gradually decrease over long periods of time.
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ECO OPTION
Set the option when [ECO] is selected for [ECO MODE].
CONSTANT BRIGHTNESS:

OFF	������������������������ The CONSTANT BRIGHTNESS feature will not work. The lamp brightness will gradually decrease over long 
periods of time.

ON	������������������������� The lamp brightness will increase according to the lamp use of time and will be kept at the lamp brightness 
equivalent to the brightness at ECO. After the lamp brightness reaches the maximum, the lamp brightness will 
gradually decrease over long periods of time. The lamp brightness will be kept longer than at NORMAL.

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video.

OFF	������������������������ This exits the closed caption mode.
CAPTION 1-4	��������� Text is superimposed.
TEXT 1-4	���������������� Text is displayed.

NOTE:
•	 The closed caption is not available under the following conditions:
-	 when messages or menus are displayed.
-	 when an image is magnified, frozen, or muted.

•	 Portions of superimposed text or closed caption may be truncated. If that happens, try to place the superimposed text or 
closed caption within the screen.

Using Off Timer [OFF TIMER]
1.	 Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.

2.	 Press the ENTER button on the remote control.

3.	 The remaining time starts counting down.

4.	 The projector will turn off after the countdown is complete.

NOTE:
•	 To cancel the preset time, set [OFF] for the preset time or turn off the power.
•	 When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 
MINUTES] message will be displayed on the bottom of the screen.

Selecting Menu Language [LANGUAGE]
You can choose one of 29 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
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[MENU]

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [SOURCE DISPLAY]
This option turns on or off input name display such as COMPUTER, HDMI1, HDMI2, VIDEO, USB-A, LAN, USB-B, 
to be displayed on the top right of the screen.
When no input signal is present, the no-signal guidance prompting you to check for an available input will be displayed 
at the center of the screen. When the [USB-A] or [LAN] item is selected for [SOURCE], the no-signal guidance will 
not be displayed.

Turning ON/OFF Control ID [ID DISPLAY]
ID DISPLAY	����������� This option turns on or off the ID number which is displayed when the ID SET button on the remote control 

is pressed.

Turning On / Off Eco Message [ECO MESSAGE]
This option turns on or off the following messages when the projector is turned on. 

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message 
to prompt you to select [AUTO ECO], [NORMAL], or [ECO] for [ECO MODE].

When [AUTO ECO], [NORMAL], or [ECO] is selected for [ECO MODE]

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 
30 seconds.

When [OFF] is selected for [ECO MODE]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 31)
To close the message, press the EXIT button.
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Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The 
preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the fac-
tory preset.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is 
[BLUE].
NOTE: 
•	 If the [LOGO] item is selected for [BACKGROUND] with the [LAN] or [USB-B] source selected, the [LOGO] item will be selected 
regardless of its selection.

•	 When [SOURCE DISPLAY] is turned on, the no-signal guidance prompting you to check for an available input will be displayed 
at the center of the screen regardless of its selection.

•	 Your setting will not be affected even when [RESET] is done from the menu.
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[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, 
desktop rear projection, and ceiling front projection.

DESKTOP FRONT CEILING REAR

DESKTOP REAR CEILING FRONT

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
•	 This CONTROL PANEL LOCK does not affect the remote control functions.
•	 When the control panel is locked, pressing and holding the SOURCE button on the projector cabinet for about 10 seconds will 
change the setting to [OFF].

TIP: When the [CONTROL PANEL LOCK] is turned on, a key lock icon [  ] will be displayed at the bottom right of the menu.

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 33)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.



98

5. Using On-Screen Menu

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 38400 bps. The 
default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equip-
ment, a lower baud rate may be recommended for long cable runs).

NOTE: Your selected communication speed will not be affected even when [RESET] is done from the menu.

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL 
ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together 
using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER	�������Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID	�����������������������Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID set-

ting.

NOTE: 
•	 When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support 
the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)

•	 Your setting will not be affected even when [RESET] is done from the menu.
• 	Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control 
ID.

Assigning or Changing the Control ID
1.	 Turn on the projector.

2.	 Press the ID SET button on the remote control.

	 The CONTROL ID screen will be displayed.

	 If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector 
cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive 
projector, assign the control ID used for the projector by using the following procedure (Step 3).

3.	 Press one of numeric keypad buttons while pressing and holding the ID SET button 
on the remote control.

	 Example:

	 To assign “3”, press the “3” button on the remote control.

	 No ID means that all the projectors can be operated together with a single remote control. 
To set “No ID”, enter “000” or press the CLEAR button.

TIP: The range of IDs is from 1 to 254.

4.	 Release the ID SET button.

	 The updated CONTROL ID screen will be displayed.

NOTE: 
• 	The IDs can be cleared in a few days after the batteries are run down or removed.
• 	Accidentally pressing any one of the buttons of the remote control will clear currently specified ID with 
batteries removed.
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Using Test Pattern [TEST PATTERN]
Displays the test pattern to check for image distortion at the time of the projector setup. Press the ENTER button to 
display the test pattern; press the EXIT button to close the test pattern and return to the menu. Menu operation and 
keystone correction are not possible when the test pattern is displayed.

Selecting Microphone Type [MIC SELECT]
This feature allows you to select dynamic or condenser type for your microphone.
 
Setting MIC Gain [MIC GAIN]
This feature allows you to adjust your microphone sensitivity when it is connected to the MIC input jack of the projec-
tor. Microphone volume can be adjusted with the VOL. (+) or (−) button on the remote control or the ◀ or ▶ on the 
projector cabinet.

[OPTIONS(1)]

Selecting Fan Mode [FAN MODE]
This option allows you to select three modes for fan speed: Auto mode, High speed mode, and High Altitude mode.

AUTO	��������������������� The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH	���������������������� The built-in fans run at high speed.
HIGH ALTITUDE	����� The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 

5500 feet/1700 meters or higher.

When you wish to cool down the temperature inside the projector quickly, select [HIGH].

NOTE: 
•	 It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
• 	Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters or higher.
•	 Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH ALTITUDE] can cause 
the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.

• 	Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTITUDE] can cause the 
lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].

• 	Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical components such 
as the lamp.

•	 Your setting will not be affected even when [RESET] is done from the menu.
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Selecting Signal Format [COLOR SYSTEM]
This feature allows you to select video standards manually.
Normally select [AUTO]. Select the video standard from the pulldown menu. 

Enabling or Disabling WXGA Mode [WXGA MODE]
Selecting [ON] will give priority to WXGA (1280 × 768)/WUXGA (1920 × 1080) signals in recognizing an input sig-
nal.
When [WXGA MODE] is set to [ON], XGA (1024 × 768)/UXGA (1600 × 1200) signals may not be recognized on 
M332XS. In this case, select [OFF].

NOTE: 
•	 The [OFF] is selected at the time of shipment of M332XS.
•	 The [ON] is selected at the time of shipment of M352WS/M302WS.

Setting HDMI1/2 [HDMI SETTINGS]
Make the settings for each video level when connecting HDMI equipment such as a DVD player. 

VIDEO LEVEL	��������� Select [AUTO] to automatically detect video level. If automatic detection may not work well, select [NOR-
MAL] to disable the [ENHANCED] feature of your HDMI equipment or select [ENHANCED] to improve image 
contrast and increase detail in the dark areas.

NOTE:
•	 If the projector does not reflect the settings for your HDMI equipment such as a DVD player connected to the HDMI 1 IN or HDMI 
2 IN connector, select the HDMI1 or HDMI2 input source again on the projector.

Setting Audio [AUDIO SELECT]
Make the settings for each audio level when connecting HDMI equipment, your network, and USB-B port. Select 
between each equipment and computer.

HDMI	��������������������� Select [HDMI1] or [HDMI2] to switch the HDMI 1 or HDMI 2 IN digital audio signal or select [COMPUTER] 
to switch the COMPUTER input audio signal.

LAN	������������������������ Select [LAN] or [COMPUTER] to switch the source connected to the network.
USB-B	�������������������� Select [USB-B] or [COMPUTER] to switch the source connected over the USB cable (USB-B).

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are per-
formed.

- Displaying the main menu 

- Switching sources

- Resetting data by using [RESET]

- Pressing POWER ON or STANDBY button
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[OPTIONS(2)]

Selecting Standby condition in [STANDBY MODE]
The projector has two standby modes: [NORMAL] and [NETWORK STANDBY].
The [NORMAL] mode is the mode that allows you to put the projector in the power-saving condition which consumes 
less power than the [NETWORK STANDBY] mode. The projector is preset for the [NORMAL] mode at the factory.

NORMAL	�����������������������������POWER indicator: Red light/STATUS indicator: Off
When [NORMAL] is selected, only the following buttons and feature will work:
POWER button on the projector cabinet and the remote control, and powering on from PC Control 
command.

NETWORK STANDBY	����������POWER indicator: Orange light/STATUS indicator: Off
When [NETWORK STANDBY] is selected, the projector can be turned on over a wired LAN connec-
tion and only the following buttons, port, and features will work:
POWER button on the projector cabinet and the remote control, powering on from PC Control 
command, DIRECT POWER ON, AUTO POWER ON(COMP.), LAN port, wireless LAN unit (optional), 
Virtual Remote Tool, LAN feature, and Mail Alert feature.

Important:
-	 When [NETWORK STANDBY] is selected, [AUTO POWER OFF] will turn grey in color and be disabled, and [0:15] will be selected 
automatically.

NOTE: 
•	 Even when [NORMAL] or [NETWORK STANDBY] is selected for [STANDBY MODE], power on or off can be done by using the PC 
CONTROL port.

•	 The power consumption in the standby mode will not be included in calculating CO2 emission reduction.
•	 Your setting will not be affected even when [RESET] is done from the menu.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the 
need to always use the POWER button on the remote control or projector cabinet.
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Turning On the Projector By Applying Computer Signal [AUTO POWER ON(COMP.)]
When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER 
IN input will power on the projector and simultaneously project the computer’s image.
This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet 
to power on the projector.
To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE: 
•	 Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in com-
bination of the AUTO POWER OFF function.

•	 This function will not be available under the following conditions:
-	 when a component signal is applied to the COMPUTER IN connector
-	 when a Sync on Green RGB signal or composite sync signal is applied

•	 To enable the AUTO POWER ON(COMP.) after turning off the projector, wait 3 seconds and input a computer signal.
	 If a computer signal is still present when the projector is turned off, the AUTO POWER ON(COMP.) will not work and the projector 
remains in standby mode.

Enabling Power Management [AUTO POWER OFF]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 5min., 10min., 
15min., 20min., 30min., 60min.) if there is no signal received by any input or if no operation is performed.

NOTE:
•	 This item can be selected only when [NORMAL] is selected for [STANDBY MODE].
•	 When [NETWORK STANDBY] is selected, [AUTO POWER OFF] will turn grey in color and be disabled and [0:15] will be selected 
automatically.

Selecting Default Source [DEFAULT SOURCE SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST	���������������������� Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO	��������������������� Searches for an active source in order of COMPUTER → HDMI1 → HDMI2 → VIDEO → USB-A → USB-B 

→ COMPUTER and displays the first found source.
COMPUTER	����������� Displays the computer signal from the COMPUTER IN connector every time the projector is turned on.
HDMI1	������������������� Displays the digital source from the HDMI 1 IN connector every time the projector is turned on. 
HDMI2	������������������� Displays the digital source from the HDMI 2 IN connector every time the projector is turned on. 
VIDEO	�������������������� Displays the Video source from the VIDEO IN connector every time the projector is turned on.
USB-A	�������������������� Displays slides or plays back movie files from the USB memory device every time the projector is turned 

on.
LAN	������������������������ Displays a signal from LAN port (RJ-45) or the USB Wireless LAN Unit.
USB-B	�������������������� Displays the computer signal from the USB-B port  every time the projector is turned on.
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Setting carbon footprint factor [CARBON CONVERT]
Adjusts the carbon footprint factor in the carbon saving calculation. The initial setting is 0.505[kg-CO2/kWh] based on 
the CO2 Emissions from Fuel Combustion (2008 Edition) published by OECD.

Selecting your currency [CURRENCY]
Displays electricity pricing (available in 4 currency units).

$	���������������������������� US Dollar
€	��������������������������� EU Euro
JP¥	������������������������ Japanese Yen
RMB¥	�������������������� Chinese Yuan

Changing currency setting and currency convert setting [CURRENCY CONVERT]
Changes currency setting and currency convert setting for CARBON METER.
The initial setting are as follows:

US Dollar	��������������� 0.11 [$/kWh]
EU Euro	����������������� 0.19 [€/kWh]
Japanese Yen	��������� 20 [¥/kWh]
Chinese Yuan	��������� 0.48 [¥/kWh]

The initial settings for US dollar, EU Euro, and Japanese Yen are based on “Energy Prices and Taxes (second quarter 
2010” published by OECD.
The initial setting for Chinese Yuan is based on “Chinese Data File (2010)” published by JETRO.
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[3D]

Selecting input connected to a source of 3D images [COMPUTER/HDMI1/HDMI2/VIDEO]

[3D]
This function switches the 3D mode between ON and OFF for each input.

ON	������������������������� Turns on the 3D mode for the selected input.

NOTE:
To confirm that the supported 3D signal is accepted, use either way of the following:
•	 Make sure that [3D] is displayed in the top right of the screen after the source is selected.
•	 Display [INFO.] → [SOURCE] → [3D SIGNAL] and make sure that “SUPPORTED” is displayed.

OFF	������������������������ Turns off the 3D mode for the selected input.

[GLASSES]
Select a 3D glass method.

DLP® Link	�������������� For 3D eyeglasses (ones manufactured by XPAND are recommended) or DLP® Link compatible LCD shutter 
eyeglasses.

Others	�������������������� For other LCD shutter eyeglasses such as IR or wired LCD shutter types.

[FORMAT]
Sets 3D format.
NOTE: This option will not work for VIDEO source.

AUTO	����������������������������������Automatically selects the appropriate format. The supported format is HDMI 3D only.
SIDE BY SIDE	���������������������Selects this format for the SIDE BY SIDE 3D image. SIDE BY SIDE is a format that stores the left 

and right eye images displayed horizontally. Only the half of the horizontal resolution is supported 
TOP AND BOTTOM	�������������Selects this format for the TOP AND BOTTOM 3D image. TOP AND BOTTOM is a format that stores the 

left and right eye images displayed vertically. Only the half of the vertical resolution is supported.
FRAME PACKING	����������������Selects this format for the FRAME PACKING 3D image. FRAM PACKING is a format that stores the 

left and right eye images without compression.
FRAME SEQUENTIAL	����������Selects this format for the FRAME SEQUENTIAL 3D image. FRAME SEQUENTIAL is a format that 

displays the left and right eye images alternately. This format is available only for COMPUTER 
input.

NOTE:
This function will not work for VIDEO source.
This option is available only when [DLP® Link] is selected for [GLASSES].
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[L/R INVERT]
Change the setting if you have difficulty seeing 3D images.

NON-INVERT	��������� Normal setting.
INVERT	������������������ Changes the order of displaying the images for left eye and right eye.

NOTE:
This option is available only when [DLP® Link] is selected for [GLASSES].
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Setting up the Projector for a Wired LAN Connection [WIRED LAN]

Important
•	 Consult with your network administrator about these settings.
•	 When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projec-

tor. (→ page 123)

TIP: The network settings you make will not be affected even when [RESET] is done from the menu.

[WIRED LAN] [DISABLE] Wired LAN connection will be turned off.

[ENABLE] Wired LAN connection will be turned on.

[SETTINGS] [DHCP] ON	�������������������������� IP address, subnet mask, and gateway will 
be automatically assigned to the projector 
from your DHCP server.

OFF	������������������������� Specify IP address, subnet mask, and gate-
way assigned by your network administra-
tor.

[IP ADDRESS] Set your IP address of the network connected to the 
projector.

[SUBNET MASK] Set your subnet mask number of the network connected 
to the projector.

[GATEWAY] Set the default gateway of the network connected to the 
projector.

[AUTO DNS] ON	��������������������������DHCP server will automatically assign IP 
address of DNS server connected to the 
projector.

OFF	������������������������� Set your IP address of DNS server connected 
to the projector.

[RECONNECT] Retry to connect the projector to a network.
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Setting up the Projector for a Wireless LAN Connection (with the optional USB Wireless 
LAN Unit equipped) [WIRLESS LAN]

Important
•	 Consult with your network administrator about these settings.
•	 When using a wireless LAN connection, attach the optional USB Wireless LAN to the projector. (→ page 124)

[PROFILE] [DISABLE] Wireless LAN connection will be turned off

[EASY CONNECTION] Select [EASY CONNECTION] to execute a wireless LAN 
easily using Image Express Utility Lite on the supplied 
NEC Projector CD-ROM.

[SIMPLE ACCESS 
POINT]

Set the projector for simple access point.
Selecting [SIMPLE ACCESS POINT] will allow the projec-
tor to create an infrastructure network. The IP address of 
the projector will be set automatically. 
Select "Obtain an IP Address Automatically" to set the IP 
address of a connected computer.  
It takes a few seconds for a change of your computer's IP 
address to come into effect in Windows 7/Windows Vista 
while it takes one or two minutes in Window XP. 
When you connect with your computer to save your profile 
and select "Automatically connect when within range" from 
the Properties tab of Wireless Network in Windows for your 
selected profile, your wireless LAN will be accessed under 
the following conditions:

•	 at the time of turning on the computer or the projec-
tor

•	 when the notebook type is within the range of the 
projector's wireless LAN can be achieved.

Data transmission between wireless LAN and wired LAN 
is not possible. 
When the [SIMPLE ACCESS POINT] mode is used to 
send images, it is recommended to connect to only one 
computer.

[PROFILE 1] Up to two settings for the USB wireless LAN unit can be 
stored in memory of the projector. (→ page 48)
To recall the settings from memory, select [PROFILE 1] or 
[PROFILE 2] from [PROFILE].

[PROFILE 2]

[RECONNECT] Retry to connect the projector to a network. Try this if you have changed [PROFILE].

NOTE: After selecting [EASY CONNECTION] from [PROFILE], you cannot make settings to [DHCP], [IP ADDRESS], [SUBNET MASK], 
[GATEWAY], and [AUTO DNS] except [CHANNEL]. 
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Hints on How to Set Up LAN Connection

To set up the projector for a LAN connection:
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → 
[SETTINGS] → [WIRELESS LAN] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for the USB Wireless LAN Unit.
Next select [SETTINGS] for your selected profile, and set [ENABLE] or [DISABLE] for [DHCP], [IP ADDRESS], 
[SUBNET MASK], and [GATEWAY]. Last click [SAVE]. To reflect changes, click the [SETTING] tab and then click 
[APPLY]. (→ page 48)

To recall LAN settings stored in the profile number:
To use [PROFILE 1] or [PROFILE 2] set on the HTTP server, from the projector’ menu, select [SETUP] → [WIRE-
LESS LAN] → [PROFILE] → [PROFILE 1] or [PROFILE 2]. Last select [YES] and press the ENTER button. (→ 
page 107)

To connect a DHCP server:
From the projector menu, select [SETUP] → [WIRED LAN] → [SETTINGS] → [DHCP] → [ON] and press the ENTER 
button. To specify IP address without using the DHCP server, use the HTTP server function. (→ page 45)

To set only for wireless LAN (NETWORK TYPE and WEP/WPA):
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → 
[SETTINGS] → [WIRELESS LAN] → [PROFILE 1] or [PROFILE 2].
Make necessary settings for [SETTINGS] and click [SAVE].
From the projector menu, select [SETUP] → [WIRELESS LAN] → [PROFILE] → [PROFILE 1] or [PROFILE 2]. 

To select an SSID:
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → 
[SETTINGS] → [WIRELESS LAN] → [CONNECTION] → [SITE SURVEY] and select the ID.
If you do not use [SITE SURVEY], type the SSID in [CONNECTION] and select [INFRASTRUCTURE] or [AD HOC]. 
(→ page 48)

To receive lamp replacement time or error messages via e-mail:
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → 
[ALERT MAIL], and set [SENDER’S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT’S ADDRESS]. Last, 
click [SAVE]. (→ page 50)

To execute [EASY CONNECTION] using Image Express Utility Lite:
The [EASY CONNECTION] is a mode that can abbreviate the troublesome LAN settings when using the Image 
Express Utility Lite and connecting the PC and projector via a wireless LAN.
The Image Express Utility Lite is contained on the supplied NEC Projector CD-ROM. 

To use [EASY CONNECTION], access the HTTP server function to display the web browser (→ page 45) and select 
[NETWORK SETTINGS] → [SETTINGS] → [WIRELESS LAN] → [EASY CONNECTION]. Next select [SETTINGS] 
→ [CHANNEL]. Last click [SAVE].
From the projector menu, select [SETUP] → [WIRELESS LAN] → [PROFILE] → [EASY CONNECTION]. 
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❼ Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and lamp usage. This item has six pages. The information included is as 
follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LAMP LIFE REMAINING] (%)*
[LAMP HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)
[TOTAL COST SAVINGS]($)

*	 The progress indicator shows the percentage of remaining bulb life.

	 The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE 
REMAINING bar indicator changes from 0% to 100 Hours and starts counting down.

	 If the remaining lamp time reaches 0 hours, the projector will not turn on.

•	 The message to the effect that the lamp should be replaced will be displayed for one minute when the projec-
tor is turned on and when the POWER button on the projector or the STANDBY button on the remote control is 
pressed.

	 To dismiss this message, press any button on the projector or the remote control.

Lamp life (H) Brightness by mode
OFF AUTO ECO NORMAL ECO OFF AUTO ECO NORMAL ECO

M352WS

3500H

3500H to 
6000H

5000H
8000H 100%

OFF thru 
ECO

Approx. 81%
Approx. 60%

M332XS

M302WS
3500H to 
7000H

5500H Approx. 76%

•	 [TOTAL CARBON SAVINGS]

	 This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving cal-
culation is based on the OECD (2008 Edition). (→ page 32)
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[SOURCE(1)]

[RESOLUTION]	 [HORIZONTAL FREQUENCY]
[VERTICAL FREQUENCY]	 [SYNC TYPE]
[SYNC POLARITY]	 [SCAN TYPE]

[SOURCE(2)]

[SIGNAL TYPE]	 [VIDEO TYPE]
[BIT DEPTH]	 [VIDEO LEVEL]
[3D SIGNAL]

[WIRED LAN]

[IP ADDRESS]	 [SUBNET MASK]
[GATEWAY]	 [MAC ADDRESS]
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[WIRELESS LAN]

[IP ADDRESS]	 [SUBNET MASK]
[GATEWAY]	 [MAC ADDRESS]
[SSID]	 [NETWORK TYPE]
[WEP/WPA]	 [CHANNEL]
[SIGNAL LEVEL]

[VERSION(1)]

[FIRMWARE] Version
[DATA] Version

[VERSION(2)]

[FIRMWARE2] Version
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[OTHERS]

[PROJECTOR NAME]
[MODEL NO.]
[SERIAL NUMBER]
[LAN UNIT TYPE]
[CONTROL ID] (when [CONTROL ID] is set)
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❽ Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source (s) except 
the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels. 
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], 
[ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], [OVERSCAN], [NOISE REDUCTION], and 
[TELECINE]..

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [SECURITY], [COMMUNICATION SPEED], 
[CONTROL ID], [STANDBY MODE], [FAN MODE], [CARBON CONVERT], [CURRENCY], [CURRENCY CON-
VERT], [LAMP LIFE REMAINING], [LAMP HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and 
[WIRELESS LAN].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press 
the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the 
lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press the 
HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.
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32

1

This section describes how to set up your projector and how to connect video and audio sources.
Your projector is simple to set up and use. But before you get started, you must first:

①	 Set up a screen and the projector.

②	 Connect your computer or video equip-
ment to the projector.

	 (→ page 117, 119, 120, 121, 122, 
123)

③	 Connect the supplied power cord. 
(→ page 16)

NOTE: Ensure that the power cord and any other 
cables are disconnected before moving the pro-
jector. When moving the projector or when it is 
not in use, cover the lens with the sliding lens 
cover.

❶ Setting Up the Screen and the Projector
Selecting a Location

[M332XS]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is ap-
proximately 60" (1.52 m) measured diagonally when the projector is roughly 27 inches (0.68 m) from the wall or screen. 
The largest the image can be is 150" (3.8 m) when the projector is about 69 inches (1.8 m) from the wall or screen.

150"

120"

Distance (Unit: m
/inch)

Lens center

Screen Size

1.4/55" 1.8/69.2"

1.2/45.5"
0.9/36"

0.7/26.6"

203.2(W)�152.4(H) / 80(W)�60(H)

162.6(W)�121.9(H) / 64(W)�48(H)

121.9(W)�91.4(H) / 48(W)�36(H)

Screen Size (Unit: cm/inch)

304.8(W)�228.6(H) / 120(W)�90(H)

243.8(W)�182.9(H) / 96(W)�72(H)

100"

80"

60"

TIP:
•	 Digital Zoom can result in a blurry image due to the electronic zoom.
•	 For more details on throw distance, see page 116.

To the wall outlet.
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[M352WS/M302WS]
The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is ap-
proximately 60" (1.52 m) measured diagonally when the projector is roughly 22 inches (0.6 m) from the wall or screen. 
The largest the image can be is 150" (3.8 m) when the projector is about 58 inches (1.5 m) from the wall or screen.

150"

120"

Distance (Unit: m
/inch)

Lens center

Screen Size

1.2/46.3" 1.5/58.3"

1/38.3"

0.8/30.3"

0.6/22.2"

Screen Size (Unit: cm/inch)

323.1(W)�201.9(H) / 127(W)�79(H)

258.5(W)�161.5(H) / 102(W)�64(H)

100"

80"

60"

215.4(W)�134.6(H) / 85(W)�53(H)

172.3(W)�107.7(H) / 68(W)�42(H)

129.2(W)�80.8(H) / 51(W)�32(H)

TIP:
•	 Digital Zoom can result in a blurry image due to the electronic zoom.
•	 For more details on throw distance, see page 116.
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B

D

C

α

Throw Distance and Screen Size
The following shows the proper relative positions of the projector and screen. Refer to the table to determine the 
position of installation.

Distance Chart

B =	 Vertical distance between lens center and 
screen center

C =	 Throw distance
D =	 Vertical distance between lens center and 

screen bottom (top of screen for ceiling ap-
plication)

α =	 Throw angle

NOTE: The values in the tables are design values and 
may vary.

[M332XS]
Screen Size

B
C

D
α

Diagonal Width Height wide wide
inch mm inch mm inch mm inch mm inch mm inch mm degree

60 1524 48 1219 36 914 24 617 27 675 6 160 40.8
80 2032 64 1626 48 1219 32 823 36 915 8 214 40.8

100 2540 80 2032 60 1524 41 1029 46 1156 11 267 40.7
120 3048 96 2438 72 1829 49 1235 55 1396 13 320 40.7
150 3810 120 3048 90 2286 61 1543 69 1757 16 400 40.7

[M352WS/M302WS]
Screen Size

B
C

D
α

Diagonal Width Height wide wide
inch mm inch mm inch mm inch mm inch mm inch mm degree

60 1524 51 1292 32 808 21 524 22 565 5 120 40.9
80 2032 68 1723 42 1077 27 698 30 769 6 160 40.8

100 2540 85 2154 53 1346 34 873 38 973 8 199 40.8
120 3048 102 2585 64 1615 41 1047 46 1177 9 239 40.7
150 3810 127 3231 79 2019 52 1309 58 1482 12 299 40.7

WARNING
*	 Installing your projector on the ceiling must be done by a qualified technician. Contact your NEC dealer for more 

information.
*	 Do not attempt to install the projector yourself.
•	 Only use your projector on a solid, level surface. If the projector falls to the ground, you can be injured and the 

projector severely damaged.
•	 Do not use the projector where temperatures vary greatly. The projector must be used at temperatures between 

41°F (5°C) and 104°F (40°C) (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C).
•	 Do not expose the projector to moisture, dust, or smoke. This will harm the screen image.
•	 Ensure that you have adequate ventilation around your projector so heat can dissipate. Do not cover the vents on 

the side or the front of the projector.

Reflecting the Image
Using a mirror to reflect your projector’s image enables you to enjoy a much larger image when a smaller space is 
required. Contact your NEC dealer if you need a mirror system. If you’re using a mirror system and your image is 
inverted, use the MENU and ▲▼◀▶ buttons on your projector cabinet or your remote control to correct the orienta-
tion. (→ page 97)

Screen center

Lens center

Screen bottom
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HDMI 2 IN

HDMI 1 IN

COMPUTER INUSB-B

AUDIO IN

Computer cable (VGA) (supplied)
To mini D-Sub 15-pin connector 
on the projector. It is recommend-
ed that you use a commercially 
available distribution amplifier if 
connecting a signal cable longer 
than the cable supplied.

NOTE: For Mac, use a commercially 
available pin adapter (not sup-
plied) to connect to your Mac’s 
video port.

A commercially available USB cable 
(compatible with USB 2.0 specifications)

Stereo mini-plug audio 
cable (not supplied)

❷ Making Connections
NOTE: When using with a notebook PC, be sure to connect the projector and notebook PC while the projector is in standby mode 
and before turning on the power to the notebook PC.
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power manage-
ment software.

Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector.
When using a PC compatible laptop, a combination of function keys will enable/disable the external display.
Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on 
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through 
external display selections.

Connecting Your Computer

NOTE: Signals supported by Plug & Play (DDC2)

INPUT
COMPUTER IN HDMI 1 IN HDMI 2 IN

analog digital digital
Yes Yes Yes

HDMI cable (not supplied)
Use High Speed HDMI® 
Cable.
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•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER IN  COMPUTER (COMP1)

HDMI 1 IN  HDMI1 HDMI1

HDMI 2 IN  HDMI2 HDMI2

USB-B  USB-B (USB-B)

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video source is played back via a commercially available scan converter. 
This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.
*	 When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
	 Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.
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Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer 
analog image you’re projecting.

NOTE:
•	 Daisy chain connection is not possible.
•	 When audio equipment is connected, the projector speaker is disabled.

Monitor out and sleep mode:
•	 The MONITOR OUT (COMP.) connector will not work when [NORMAL] is selected for [STANDBY MODE].
	 The MONITOR OUT (COMP.) connector will work only in the sleep mode.
	 Applying a signal from the COMPUTER IN connector will put the projector in the sleep mode, which allows you to 

use the MONITOR OUT(COMP.) connector and the AUDIO OUT mini jack. Sound from the MIC input jack will be 
output to the AUDIO OUT mini jack.

	 The sleep mode is one of the standby modes. The sleep mode cannot be selected from the menu.
•	 In the network standby mode,  sound for the last viewed computer or video source will be heard.
 	 BNC-to- D-SUB converted signal will not be output in the standby mode and sleep mode.

MONITOR OUT(COMP.)AUDIO OUT

Computer cable (VGA) (supplied)

Stereo mini-plug audio cable (not supplied)

Computer cable (VGA) 
(not supplied)
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Connecting Your DVD Player or Other AV Equipment
Connecting Video Input

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

VIDEO IN  VIDEO (VIDEO)

NOTE: The AUDIO IN L and R jacks (RCA) are shared between the Video inputs.

NOTE: Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

NOTE: An image may not be displayed correctly when a Video source is played back in fast-forward or fast-rewind via a scan 
converter.

VIDEO IN

AUDIO IN

Audio cable (not supplied)
Video cable (not supplied)

Audio equipment

Audio cable (not supplied)
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Connecting Component Input

•	 Select the source name for its appropriate input connector after turning on the projector.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

COMPUTER IN  COMPUTER (COMP1)

NOTE: Refer to your DVD player’s owner’s manual for more information about your DVD player’s video output requirements.

COMPUTER INAUDIO IN

Audio cable (not supplied)

15-pin - to - RCA (fe-
male) × 3 cable adapter 
(ADP-CV1E)

Stereo mini plug - to - RCA audio 
cable (not supplied)

Component video RCA × 3 
cable (not supplied)

DVD player

Audio Equipment
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HDMI 2 INHDMI 1 IN

Connecting HDMI Input
You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the 
HDMI IN connector of your projector.
NOTE: The HDMI IN connector supports Plug & Play (DDC2B).

Audio cable (not supplied)

HDMI cable (not supplied)
Use High Speed HDMI® Cable.

Input connector
SOURCE button on the projector 

cabinet
Button on the remote control

HDMI 1 IN  HDMI1 HDMI1

HDMI 2 IN  HDMI2 HDMI2

TIP: For users of audio video equipment with an HDMI connector:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal”.
This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

•	 When connecting the HDMI IN connector of the projector to the DVD player, the projector’s video level can be 
made settings in accordance with the DVD player’s video level. In the menu select [HDMI SETTINGS] → [VIDEO 
LEVEL] and make necessary settings.

•	 If the HDMI input sound cannot be heard, in the menu select [HDMI SETTINGS] → [AUDIO SELECT] → [HDMI1] 
or [HDMI2]. 

Audio Equipment
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Connecting to a Wired LAN
The projector comes standard with a LAN port (RJ-45) which provides a LAN connection using a LAN cable. 
To use a LAN connection, you are required to set the LAN on the projector menu.  Select [SETUP] → [WIRED LAN]. 
(→ page 106).

Example of LAN connection
Example of wired LAN connection

Server

Hub

LAN cable (not supplied)

NOTE: Use a Category 5 or higher 
LAN cable.
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Connecting to a Wireless LAN (Optional: NP02LM series)
The USB Wireless LAN Unit also provides a wireless LAN connection. To use a wireless LAN connection, you are 
required to assign an IP address to the projector.

Important:
•	 If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is 

prohibited, remove the USB Wireless LAN Unit from the projector.

•	 Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE: 
•	 When the projector is turned on with the optional wireless LAN unit inserted, the indicator will light up blue and the green LED 
on the USB Wireless LAN Unit flashes to show that the USB Wireless LAN Unit is working.

•	 Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11b/g/n) standard.

Flow of Setting Wireless LAN
Step 1:	 Attach the USB Wireless LAN Unit to the projector.

Step 2:	 Connect the computer to the projector via wired LAN. (→ page 123)

	 Use the computer’s browser to display the projector’s HTTP server. (→ page 45)

Step 3:	 Use an HTTP server to set the wireless LAN. (→ page 48)

	 Access the HTTP server function to set [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS] → 
[EASY CONNECTION], [SIMPLE ACCESS POINT], [PROFILE1] or [PROFILE2].

NOTE: 
•	 To use the HTTP server function, the projector must be connected to a network.
	 First use the wired LAN to connect the projector to a network and then use the HTTP server to set the wireless LAN.
•	 After setting the wireless LAN by using the HTTP server, set [NETWORK SETTINGS] → [SETTINGS] → [WIRED] → [DISABLE]

When switching to set on the projector after connecting to the wireless LAN:
Use the menu to set the wireless LAN connection for the projector. 
(→ page 107)
Select [DISABLE], [EASY CONNECTION] , [PROFILE1] or [PROFILE2] you set from the HTTP server.

Attaching the USB Wireless LAN Unit

NOTE:
•	 The USB Wireless LAN Unit must be inserted into the USB Wireless LAN Unit port in the correct direction. It cannot be inserted 
in the reverse direction. If the USB Wireless LAN Unit is inserted in the reverse direction with excessive force applied, the USB 
port may break.

•	 Before touching the USB Wireless LAN Unit, touch a metallic object (such as a door knob or aluminum window frame) to discharge 
the static electricity from your body.

•	 Always insert or remove the USB Wireless LAN unit when the main power is turned off. Failure to do so may cause projector 
malfunction or damage to the USB wireless LAN unit. If the projector will not work correctly, turn off the projector, disconnect 
the power cord, and then connect it again.

•	 Do not insert other USB devices into the USB Wireless LAN unit port. Do not insert the USB Wireless LAN unit into the USB-B 
port (Type B).
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Prepare a Phillips screw driver beforehand.

1.	 Press the POWER button to turn off the projector and set it 
into standby condition, and disconnect the power cord.

2.	 Remove the USB (LAN) port cover.

	 Loosen the screw securing the port cover.

	 • The screw is not removable. 

3.	 Slowly insert the USB Wireless LAN Unit into the USB (LAN) 
port.

	 Remove the cap from the USB Wireless LAN Unit, and then insert 
it with the surface (side of indicator) facing outward. Keep the cap 
for later use.

NOTE: Do not force to insert the USB Wireless LAN Unit.

4.	 Put the USB (LAN) port cover back into place.

	 Insert the catch of the USB (LAN) port cover into the groove of the 
projector cabinet, and then tighten the screw to secure the port 
cover.

To remove the USB Wireless LAN Unit, disconnect the power cord 
and use the above procedure.

NOTE: 
•	 The green LED on the USB Wireless LAN Unit flashes to show that Wireless 
LAN Unit is working. If the USB Wireless LAN Unit is incorrectly attached, 
the blue LED will not flash.

•	 Do not press the button on the USB Wireless LAN Unit. The button will not 
work with this model.
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Example of wireless LAN connection
(Network Type → Infrastructure)

 PC with wireless 
LAN card inserted

PC with built-in wireless 
LAN function

Wired LAN

Wireless access point

USB Wireless LAN Unit

To enable direct communication (i.e., peer-to-peer) between personal computers and projectors, you need to 
select the Ad Hoc mode.

Use the HTTP server function to make the settings. (→ page 45)

PC with wireless 
LAN card inserted

PC with built-in wireless 
LAN function

Use the HTTP server function to make the settings. (→ page 45)

Example of wireless LAN connection (Network Type → Ad Hoc)

USB Wireless LAN Unit
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This section describes the simple maintenance procedures you should follow to clean the lens, the cabinet, and to 
replace the lamp.

❶ Cleaning the Lens
•	 Turn off the projector before cleaning.

•	 The projector has a plastic lens. Use a commercially available plastic lens cleaner.

•	 Do not scratch or mar the lens surface as a plastic lens is easily scratched.

•	 Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

❷ Cleaning the Cabinet
Turn off the projector, and unplug the projector before cleaning.
•	 Use a dry soft cloth to wipe dust off the cabinet.

	 If heavily soiled, use a mild detergent. 

•	 Never use strong detergents or solvents such as alcohol or thinner. 

•	 When cleaning the vents or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner 
into the slits of the cabinet.

Vacuum the dust off the vents.

•	 Clogged vents may cause a rise in  the internal temperature of the projector, resulting in malfunction.

•	 Do not scratch or hit the cabinet with your fingers or any hard objects

•	 Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product 
in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off. 

7. Maintenance
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❸ Replacing the Lamp
When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE LAMP 
HAS REACHED THE END OF ITS USABLE LIFE. PLEASE  REPLACE THE LAMP.” will appear (*). Even though the 
lamp may still be working, replace the lamp to maintain the optimal projector performance. After replacing the lamp, 
be sure to clear the lamp hour meter. (→ page 113)

 WARNING
•	 Do not spray flammable gas to get rid of dust and dirt that accumulate in the lens. Doing so could cause a 

fire.

 CAUTION
•	 DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector 

off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

•	 Use the specified lamp for safety and performance. 

	 To order the replacement lamp, specify your lamp type.

	 Replacement lamp:

	 NP30LP: M352WS/M332XS

	 NP28LP: M302WS

•	 DO NOT REMOVE ANY SCREWS except one lamp cover screw and three lamp housing screws. You could receive 
an electric shock.

•	 Do not break the glass on the lamp housing.

	 Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause 
an unwanted shadow and poor picture quality.

•	 The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours 
after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use 
the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered 
in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC 
dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
•	 for one minute after the projector has been powered on
•	 when the  (POWER) button on the projector cabinet or the STANDBY button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:

•	 Phillips screwdriver (plus-head)

•	 Replacement lamp

Flow of Replacing the Lamp

Step 1.	 Replace the lamp 

Step 2.	 Clear the lamp usage hours (→ page 113)
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2.	 Remove the lamp housing.

(1)	Loosen the three screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condi-
tion.

	 • The three screws are not removable.

	 • �There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this 
interlock.

(2)	Remove the lamp housing by holding it.

 CAUTION:
Make sure that the lamp housing is cool enough to before removing it.

Interlock

To replace the lamp: 
1.	 Remove the lamp cover.

(1)	Loosen the lamp cover screw

	 • The lamp cover screw is not removable.

(2)	Push and slide the lamp cover off.
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This completes the lamp replacement.
Go on to the clearing lamp hour meters. 

NOTE: When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector 
cannot turn on and the menu is not displayed.
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
 

To clear the lamp usage hours:
1.	 Place the projector where you use it.

2.	 Plug the power cord into the wall outlet, and then turn on the projector.

3.	 Clear the lamp usage hours.

From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.

4.	 Reattach the lamp cover.

(1)	Slide the lamp cover back until it snaps into place.

(2)	Tighten the screw to secure the lamp cover.

	 • Be sure to tighten the screw.

3.	 Install a new lamp housing.

(1)	Insert a new lamp housing until the lamp housing is plugged into the socket. 

(2)	Push the top center of the lamp housing to secure it.

(3)	Secure it in place with the three screws.

	 • Be sure to tighten the screws.
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❶ Troubleshooting
This section helps you resolve problems you may encounter while setting up or using the projector.
Indicator Messages
Power Indicator

Indicator Condition Projector Condition Note
Off The main power is off –

Blinking light Blue 0.5 sec On,
0.5 sec Off

The projector is getting ready to turn on. Wait for a moment.

2.5 sec On,
0.5 sec Off

Off Timer is enabled. –

Steady light Blue The projector is turned on. –
Orange The projector is [NETWORK STANDBY] mode or 

sleep mode*.
–

Red [NORMAL] is selected for [STANDBY MODE] –

Status Indicator
Indicator Condition Projector Condition Note

Off Power on or Standby ([NORMAL] or [NETWORK 
STANDBY] for [STANDBY MODE])

–

Blinking light Red 1 cycle (0.5 sec 
On, 2.5 sec Off)

Lamp cover error or lamp housing error Replace the lamp cover or lamp housing correctly.

2 cycle (0.5 sec 
On, 0.5 sec Off)

Temperature error The projector is overheated. Move the projector to 
a cooler location.

3 cycle (0.5 sec 
On, 0.5 sec Off)

Power error Power unit is not working properly. Contact your 
dealer.

4 cycle (0.5 sec 
On, 0.5 sec Off)

Fan error Fans will not work correctly.

6 cycle (0.5 sec 
On, 0.5 sec Off)

Lamp error Lamp fails to light. Wait a full minute and then turn 
on again.

Orange 1 cycle (0.5 sec 
On, 2.5 sec Off)

Network conflict Both the built-in wired LAN and the wireless LAN cannot 
be connected to the same network at the same time.
To use both built-in wired LAN and wireless LAN at the 
same time, connect them to different networks.

Green Re-firing the lamp (The projector is cooling 
down.)

The projector is re-firing.
Wait for a moment.

Steady light Green The projector is in [NORMAL] mode or sleep 
mode.

–

Orange CONTROL PANEL LOCK is on. You have pressed cabinet button when Control 
Panel Lock is on.

CONTROL ID error Remote control ID and projector ID are not 
matched.

Lamp Indicator
Indicator Condition Projector Condition Note

Off Normal –
Blinking light Red Lamp has reached its end of life. Lamp replace-

ment message will be displayed.
Replace the lamp.

Steady light Red Lamp has been used beyond its limit. The projector 
will not turn on until the lamp is replaced.

Replace the lamp.

Green [ECO MODE] is set to [AUTO ECO], [NORMAL] 
or [ECO]

–

* For more information on "sleep mode", see page 119.

Over-Temperature Protection
If the temperature inside the projector rises too high, the over-temperature protector will automatically turn off the lamp 
with the STATUS indicator blinking (2-cycle On and Off.)
Should this happen, do the following:
•	 Unplug the power cord after the cooling fans stop.
•	 Move the projector to a cooler location if the room where you are presenting is particularly too warm.
•	 Clean the vents if they are clogged with dust.
•	 Wait about 60 minutes until the inside of the projector becomes cool enough.
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Common Problems & Solutions
(→ “Power/Status/Lamp Indicator” on page 131.)

Problem Check These Items

Does not turn on
or shut down

•	 Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control 
is on. (→ pages 16, 17)

•	 Ensure that the lamp cover is installed correctly. (→ page 130)
•	 Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room 

where you are presenting is particularly warm, move the projector to a cooler location.
•	 Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its 

life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 113)
•	 The lamp may fail to light. Wait a full minute and then turn on the power again.
•	 Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters 

or higher. Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH 
ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple 
minutes and turn on the projector. (→ page 99)

	 If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for 
some time and then the projector will display the image. Wait for a moment.

Will turn off •	 Ensure that the [OFF TIMER] or [AUTO POWER OFF] is off. (→ page 94, 102)

No picture •	 Use the input select button on the remote control to select your source (COMPUTER, HDMI1, HDMI2, VIDEO, 
USB-A, LAN, or USB-B). (→ page 19) If there is still no picture, press the button again.

•	 Ensure your cables are connected properly.
•	 Use menus to adjust the brightness and contrast. (→ page 86)
•	 Ensure that the lens cap is removed. (→ page 5,17)
•	 Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 113)
•	 Enter your registered keyword if the Security function is enabled. (→ page 33)
•	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 

the power to the notebook PC.
	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 

being powered up.
*	 If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver 

or power management software.
•	 See also the next page.

Picture suddenly be-
comes dark

•	 Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, 
lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 99)

Color tone or hue is un-
usual

•	 Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 93)
•	 Adjust [HUE] in [PICTURE]. (→ page 86)

Image isn’t square to the 
screen

•	 Reposition the projector to improve its angle to the screen. (→ page 20)
•	 Use the Keystone correction function to correct the trapezoid distortion. (→ page 24)

Picture is blurred •	 Adjust the focus. (→ page 23)
•	 Reposition the projector to improve its angle to the screen. (→ page 20)
•	 Ensure that the distance between the projector and screen is within the adjustment range of the lens. 

(→ page 114)
•	 Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. 

Should this happen, let the projector stand until there is no condensation on the lens.

F l i cke r  appears  on 
screen

•	 Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 feet/1700 
meters or lower. Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTI-
TUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO]. (→ page 99)

Image is scrolling ver-
tically, horizontally or 
both

•	 Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported 
by the projector. (→ page 138)

•	 Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 88)

Remote control does 
not work

•	 Install new batteries.(→ page 11)
•	 Make sure there are no obstacles between you and the projector.
•	 Stand within 22 feet (7 m) of the projector. (→ page 11)

Indicator is lit or blink-
ing

•	 See the POWER/STATUS/LAMP Indicator. (→ page 131)

Cross color in RGB 
mode

•	 Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 26)
•	 Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 87)

For more information contact your dealer.
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If there is no picture, or the picture is not displayed correctly.

•	 Power on process for the projector and the PC.

	 Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on 
the power to the notebook PC.

	 In most cases the output signal from the notebook PC is not turned on unless connected to the projector before 
being powered up.

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, 
this means there is no signal being output from the computer. (→ page 110 or go to next step)

•	 Enabling the computer’s external display.

	 Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. 
When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usu-
ally, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on 
or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through 
external display selections.

•	 Non-standard signal output from the computer

	 If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed 
correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each 
notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. 
Refer to your computer’s documentation for detailed information.

•	 Image displayed is incorrect when using a Mac

	 When using a Mac with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) ac-
cording to your resolution. After setting, restart your Mac for the changes to take affect.

	 For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on 
a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to 
the 13" fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then 
restart the Mac again.

NOTE: A Video Adapter cable manufactured by Apple Inc. is needed for a MacBook which does not have a mini D-Sub 15-pin 
connector.

•	 Mirroring on a MacBook

*	 When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your 
MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.

•	 Folders or icons are hidden on the Mac screen

	 Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple 
menu and arrange icons.
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❷ Specifications
This section provides technical information about projector’s performance.

[M352WS/M302WS/M332XS]

Optical

Model Number NP-M352WS NP-M302WS NP-M332XS
Projection System Single DLP® chip (0.65", aspect 16:10) Single DLP® chip (0.55", aspect 

4:3)
Resolution*1 1280 × 800 pixels (WXGA) 1024 × 768 pixels (XGA)
Lens Digital zoom and manual focus

Digital Zoom Ratio = 1.2
F2.4/ f=6.5 mm

Lamp 270 W AC 
(219 W in NORMAL)
(162 W in ECO)

225 W AC 
(171 W in NORMAL)
(135 W in ECO)

270 W AC 
(219 W in NORMAL)
(162 W in ECO)

Light Output*2*3 3500 lumens 3000 lumens 3300 lumens 
NORMAL: 81% NORMAL: 76% NORMAL: 81%
ECO: 60%*4

Contrast Ratio*3

(full white: full black)
10000:1 with DYNAMIC CONTRAST ON

Image Size (Diagonal) 60–150 inches/1.52 m–3.81 m (16:10) 60–150 inches/1.52 m–3.81 m 
(4:3)

Projection Distance
(Min.–Max.)

22.2–58.3 inches/0.57–1.48 m 26.6–69.2 inches/0.68–1.76 m 

Projection Angle 40.7°–40.9° 40.7°–40.8°

*1	 Effective pixels are more than 99.99%.
*2	 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the 

[PRESET] mode, the light output value may drop slightly.
*3	 Compliance with ISO21118-2005
*4 The maximum power becomes equivalent to power in ECO (ECO MODE).

Electrical

Model Number NP-M352WS NP-M302WS NP-M332XS
Inputs 1 × RGB/Component (D-Sub 15 P), 2 × HDMI Type A (19P, HDMI® Connector) HDCP supported*5, 

1 × Video (RCA), 1 × (L/R) RCA Audio, 1 × Stereo Mini Audio
Outputs 1 × RGB (D-Sub 15P), 1 × Stereo Mini Audio
PC Control 1 × PC Control Port (D-Sub 9P)
Wired LAN Port 1 × RJ-45 (10BASE-T/100BASE-TX)
Wireless LAN Port  
(Optional)

IEEE 802.11 b/g/n (optional USB Wireless LAN Unit  required)

USB Port 1 × Type A, 1 × Type B
MIC Input 1 × Monaural Mini Audio
Color Reproduction 10-bit signal processing (1.07 billion colors) (USB-A, LAN: 16.7 million colors)

*5	 HDMI® (Deep Color, Lip Sync) with HDCP
	 What is HDCP/HDCP technology?
	 HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system 

for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).
	 If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With 

the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed 
due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

	 Video: Deep Color; 8/10/12-bit, LipSync
	 Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit
*6	 An image with higher or lower resolution than the projector’s native resolution (M332XS: 1024 × 768 / M352WS/M302WS: 1280 

× 800) will be displayed with Advanced AccuBlend.



135

8. Appendix

Model Number NP-M352WS NP-M302WS NP-M332XS
Compatible Signals*6 Analog: VGA/SVGA/XGA/WXGA/Quad-VGA/SXGA/SXGA+/WXGA+/WXGA++/UXGA/WSXGA+/HD/

Full HD/WUXGA/Mac13"/Mac16"/Mac 19"/Mac 21"/Mac 23" 
Component: 480i/480p/720p/1080i (60Hz), 576i/576p/1080i (50Hz), DVD Progressive (50/60Hz)
Digital: VGA/SVGA/XGA/WXGA/Quad-VGA/SXGA/SXGA+/WXGA+/WXGA++/WSXGA+/HDTV (1080p)/
HDTV (1080i)/HDTV (720p)/HDTV (480p)
3D: For PC XGA/1280 × 720/WXGA, For Video SDTV (480i), For HDMI-1.4a 720p (Frame Packing)/ 
1080p (Frame Packing)/1080i (Side by Side (Half))/720p (Top and Bottom)/1080p (Top and Bottom)

Horizontal Resolution 540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60
300 TV lines: SECAM

Scan Rate Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)
Vertical: 50 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)

Sync Compatibility Separate Sync
Built-in Speaker 20 W (monaural)
Power Requirement 100–240V AC, 50/60Hz
Input Current 3.9-1.6A 3.3-1.4A 3.9-1.6A
Power 
Consump-
tion
(Typical 
value)

ECO 
MODE 
OFF

354W (100-130V)
335W (200-240V)

300W (100-130V)
286W (200-240V)

354W (100-130V)
335W (200-240V)

NORMAL 292W (100-130V)
278W (200-240V)

233W (100-130V)
224W (200-240V)

292W (100-130V)
278W (200-240V)

ECO 258W (100-130V)
246W (200-240V)

210W (100-130V)
202W (200-240V)

258W (100-130V)
246W (200-240V)

STANDBY 
(NETWORK 
STANDBY)

2.5 W(100-130V)
2.9 W (200-240V)

STANDBY 
(NORMAL)

0.2W (100-130V)
0.38W (200-130V)

Mechanical

Model Number NP-M352WS NP-M302WS NP-M332XS
Installation
Orientation

Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear

Dimensions 14.5" (W) × 5.3" (H) × 11.5" (D) /368 mm (W) × 134 mm (H) × 291 mm (D)
14.5" (W) × 3.9" (H) × 11.3" (D) /368 mm (W) × 98 mm (H) × 286 mm (D) (not including protrusions)

Weight M352W/M332XS: 8.2 lbs/3.7 kg
M302WS: 8.0 lbs/3.6 kg

Environmental 
Considerations

Operational Temperatures : 41° to 104°F (5° to 40°C), 
(ECO mode selected automatically at 95°F to 104°F/35°C to 40°C) 
20% to 80% humidity (non-condensing) 
Storage Temperatures : 14° to 122°F (-10° to 50°C), 
20% to 80% humidity (non-condensing)
Operating altitude: 0 to 2400m/8000 feet (Set [FAN MODE] to [HIGH ALUTITUDE] when using the pro-
jector at altitudes approximately 1700 meters /5500 feet)

Regulations UL/C-UL Approved (UL 60950-1, CSA 60950-1)
Meets DOC Canada Class B requirements
Meets FCC Class B requirements
Meets AS/NZS CISPR.22 Class B
Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)
Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)

For additional information visit:
US : http://www.necdisplay.com/
Europe : http://www.nec-display-solutions.com/
Global : http://www.nec-display.com/global/index.html
For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.

http://www.necdisplay.com/
http://www.nec-display-solutions.com/
http://www.nec-display.com/global/index.html
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[M352WS/M302WS/M332XS]

Lens center

Lens center

Holes for ceiling mount

Unit: mm (inch)
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Attaching the Optional Cable Cover (NP05CV)
An optional cable cover (NP05CV) is available for hiding cables.

 CAUTION:
•	 Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come 

off and fall, resulting in injury or damage to the cable cover.
•	 Do not put bundled cables in the cable cover. Failure to do so may damage the power cord, resulting a fire.
•	 Do not force excessive pressure to the cable cover. Doing so may cause damage to the cable cover, resulting 

in injury.

Attaching the cable cover
Attach the cable cover after installing the projector on the ceiling and connecting cables.
Tool needed for attaching:
•	 Phillips screwdriver (plus-head)

1.	 Align two tabs on the outside of the cable cover with grooves of the projector and push the top end.

•	 At the same time two tabs on the inside of the cable cover will be engaged in the responding grooves of the 
projector.

NOTE:
•	 Be careful not to get cables caught in between the cable cover and the projector.

2.	 Tighten the cable cover screws.

•	 Be sure to tighten the screws.

1

1
2

2

Removing the cable cover
1.	 Loosen the cable cover screws until the Phillips screwdriver goes into a freewheeling condition

	

1

1

2.	 Remove the cable cover.

	 Push up the cable cover slightly and rotate it to release.
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❹ Pin Assignments of D-Sub COMPUTER Input Connector
Mini D-Sub 15 Pin Connector

Signal Level
Video signal : 0.7Vp-p (Analog)
Sync signal : TTL level

51 42 3
10

11 12 13 14 15
6 97 8

Pin No. RGB Signal (Analog) YCbCr Signal
1 Red Cr
2 Green or Sync on Green Y
3 Blue Cb
4 Ground
5 Ground
6 Red Ground Cr Ground
7 Green Ground Y Ground
8 Blue Ground Cb Ground
9 Hot plug
10 Sync Signal Ground
11 No Connection
12 Bi-directional DATA (SDA)
13 Horizontal Sync or Composite 

Sync
14 Vertical Sync
15 Data Clock

COMPUTER IN
NOTE: Pin Nos. 12 and 15 are required for DDC/CI.
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❺ Compatible Input Signal List

Analog RGB

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

VGA 640 × 480 4:3 60/72/75/85
SVGA 800 × 600 4:3 56/60/72/75/85
XGA 1024 × 768 *1 4:3 60/70/75/85
WXGA 1280 × 768 *2 15:9 60

1280 × 800 *2 16:10 60
1360 × 768 *3 16:9 60
1366 × 768 *3 16:9 60

Quad-VGA 1280 × 960 4:3 60/75
SXGA 1280 × 1024 5:4 60/75
SXGA+ 1400 × 1050 4:3 60
WXGA+ 1440 × 900 16:10 60
WXGA++ 1600 × 900 *3 16:9 60
UXGA 1600 × 1200 *4 4:3 60
WSXGA+ 1680 × 1050 16:10 60
HD 1280 × 720 16:9 60
Full HD 1920 × 1080 16:9 60
WUXGA 1920 × 1200 *5 16:10 60
MAC 13" 640 × 480 4:3 67
MAC 16" 832 × 624 4:3 75
MAC 19" 1024 × 768 4:3 75
MAC 21" 1152 × 870 4:3 75
MAC 23" 1280 × 1024 5:4 65

Component

Signal Format Aspect Ratio
Refresh Rate

( Hz )
HDTV (1080p) 1920 × 1080 16:9 50/60
HDTV (1080i) 1920 × 1080 16:9 50/60
HDTV (720p) 1280 × 720 16:9 50/60
SDTV (480p) 720 × 480 4:3/16:9 60
SDTV (576p) 720 × 576 4:3/16:9 50
SDTV (480i) 720 × 480 4:3/16:9 60
SDTV (576i) 720 × 576 4:3/16:9 50

Composite Video

Signal Aspect Ratio
Refresh Rate

( Hz )
NTSC 4:3 60
PAL 4:3 50
PAL60 4:3 60
SECAM 4:3 50

NOTE:
•	 An image with higher or lower resolution than the projector’s native resolution (M332XS: 1024 × 768 / M352WS/M302WS: 1280 
× 800) will be displayed with Advanced AccuBlend.

•	 Sync on Green and Composite sync signals are not supported.
•	 Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh 
rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.

HDMI

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

VGA 640 × 480 4:3 60
SVGA 800 × 600 4:3 60
XGA 1024 × 768 *1 4:3 60
WXGA 1280 × 768 *2 15:9 60

1280 × 800 *2 16:10 60
1366 × 768 16:9 60

Quad-VGA 1280 × 960 4:3 60
SXGA 1280 × 1024 5:4 60
SXGA+ 1400 × 1050 4:3 60
WXGA+ 1440 × 900 16:10 60
WXGA++ 1600 × 900 16:9 60
WSXGA+ 1680 × 1050 16:10 60
HDTV (1080p) 1920 × 1080 16:9 50/60
HDTV (1080i) 1920 × 1080 16:9 50/60
HDTV (720p) 1280 × 720 16:9 50/60
SDTV (480p) 720 × 480 4:3/16:9 60
SDTV (576p) 720 × 576 4:3/16:9 50
SDTV (480i) 720 

(1440)
× 480 4:3/16:9 60

SDTV (576i) 720 
(1440)

× 576 4:3/16:9 50

3D

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

For PC Signal
XGA 1024 × 768 4:3 60/120
HD 1280 × 720 16:9 60/120
WXGA 1280 × 800 16:10 60/120
HDTV (1080p) 1920 × 1080 16:9 60
For Video Signal
SDTV (480i) 720 × 480 4:3/16:9 60

HDMI 3D

Signal
Resolution

( dots )
Aspect Ratio

Refresh Rate
( Hz )

Structure: Frame Packing
1080p 1920 × 1080 16:9 23.98/24
720p 1280 × 720 16:9 50/59.94/60
Structure: Side by Side (Half)
1080i 1920 × 1080 16:9 50/59.94/60
Structure: Top and Bottom
1080p 1920 × 1080 16:9 23.98/24
720p 1280 × 720 16:9 50/59.94/60

*1	Native resolution on XGA model (M332XS) 
*2	Native resolution on WXGA model (M352WS/M302WS)
*3	The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu.
	 The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].
*4	WXGA MODE: OFF
*5	WXGA MODE: ON
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❻ PC Control Codes and Cable Connection
PC Control Codes

Function	 Code Data

POWER ON	 02H	 00H	 00H	 00H	 00H	 02H

POWER OFF	 02H	 01H	 00H	 00H	 00H	 03H

INPUT SELECT COMPUTER	 02H	 03H	 00H	 00H	 02H	 01H	 01H	 09H

INPUT SELECT HDMI 1	 02H	 03H	 00H	 00H	 02H	 01H	 A1H	 A9H

INPUT SELECT HDMI 2	 02H	 03H	 00H	 00H	 02H	 01H	 A2H	 AAH

INPUT SELECT VIDEO	 02H	 03H	 00H	 00H	 02H	 01H	 06H	 0EH

INPUT SELECT USB-A	 02H	 03H	 00H	 00H	 02H	 01H	 1FH	 27H

INPUT SELECT LAN	 02H	 03H	 00H	 00H	 02H	 01H	 20H	 28H

INPUT SELECT USB-B	 02H	 03H	 00H	 00H	 02H	 01H	 22H	 2AH

PICTURE MUTE ON	 02H	 10H	 00H	 00H	 00H	 12H

PICTURE MUTE OFF	 02H	 11H	 00H	 00H	 00H	 13H

SOUND MUTE ON	 02H	 12H	 00H	 00H	 00H	 14H

SOUND MUTE OFF	 02H	 13H	 00H	 00H	 00H	 15H

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection
Communication Protocol

Baud rate	�����������������������������������������38400 bps
Data length	��������������������������������������8 bits
Parity	�����������������������������������������������No parity
Stop bit	��������������������������������������������One bit
X on/off	��������������������������������������������None
Communications procedure..............Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Connector (D-SUB 9P)

NOTE 1: Pins 1, 4, 6 and 9 are no used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.

1 52 43

6 7 98

To GND of PC

To RxD of PC

To TxD of PC

To RTS of PC

To CTS of PC
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No image is displayed from your PC or video equipment to the 
projector.

Still no image even though you connect the projector to the PC 
first, then start the PC.
Enabling your notebook PC’s signal output to the projector.
•	 A combination of function keys will enable/disable the exter-
nal display. Usually, the combination of the “Fn” key along 
with one of the 12 function keys turns the external display 
on or off. 

No image (blue or black background, no display).
Still no image even though you press the AUTO ADJUST 
button.
Still no image even though you carry out [RESET] in the 
projector’s menu.
Signal cable’s plug is fully inserted into the input connector
A message appears on the screen.
( _____________________________________________ )
The source connected to the projector is active and available.
Still no image even though you adjust the brightness and/or 
the contrast.
Input source’s resolution and frequency are supported by the 
projector.

❼ Troubleshooting Check List
Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by 
referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem 
more efficiently.
* Print this page and the next page for your check.

Frequency of occurrence   always   sometimes (How often?_____________________)   other (__________________)

Power
No power (POWER indicator does not light blue)  See also “Status 
Indicator (STATUS)”.

Power cord’s plug is fully inserted into the wall outlet.
Lamp cover is installed correctly.
Lamp Hours Used (lamp operation hours) was cleared after 
lamp replacement.
No power even though you press and hold the POWER but-
ton.

Shut down during operation.
Power cord’s plug is fully inserted into the wall outlet.
Lamp cover is installed correctly .
[AUTO POWER OFF] is turned off (only models with the [AUTO 
POWER OFF] function).
[OFF TIMER] is turned off (only models with the [OFF TIMER] 
function).

Video and Audio

Image is too dark.
Remains unchanged even though you adjust the brightness 
and/or the contrast.

Image is distorted.
Image appears to be trapezoidal (unchanged even though you 
carry out the [KEYSTONE] adjustment).

Parts of the image are lost.
Still unchanged even though you press the AUTO ADJUST 
button.
Still unchanged even though you carry out [RESET] in the 
projector’s menu.

Image is shifted in the vertical or horizontal direction.
Horizontal and vertical positions are correctly adjusted on a 
computer signal.
Input source’s resolution and frequency are supported by the 
projector.
Some pixels are lost.

Image is flickering.
Still unchanged even though you press the AUTO ADJUST 
button.
Still unchanged even though you carry out [RESET] in the 
projector’s menu.
Image shows flickering or color drift on a computer signal.
Still unchanged even though you change [FAN MODE] from 
[HIGH ALTITUDE] to [AUTO].

Image appears blurry or out of focus.
Still unchanged even though you checked the signal’s resolution 
on PC and changed it to projector’s native resolution.
Still unchanged even though you adjusted the focus.

No sound.
Audio cable is correctly connected to the audio input of the 
projector.
Still unchanged even though you adjusted the volume level.
AUDIO OUT is connected to your audio equipment (only models 
with the AUDIO OUT connector).

Other
Remote control does not work.

No obstacles between the sensor of the projector and the 
remote control.
Projector is placed near a fluorescent light that can disturb the 
infrared remote controls.
Batteries are new and are not reversed in installation. 

Buttons on the projector cabinet do not work (only models with the 
[CONTROL PANEL LOCK] function)

[CONTROL PANEL LOCK] is not turned on or is disabled in 
the menu.
Still unchanged even though you press and hold the EXIT button 
for a minimum of 10 seconds.
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In the space below please describe your problem in detail.

Information on application and environment where your projector is used

Projector

Model number:
Serial No.:
Date of purchase:
Lamp operating time (hours):
Eco Mode:	  OFF   AUTO ECO
	  NORMAL   ECO
Information on input signal:

Horizontal synch frequency	 [      ] kHz
Vertical synch frequency	 [      ] Hz
Synch polarity	 H  (+)   (−)
	 V  (+)   (−)
Synch type	  Separate   Composite

	  Sync on Green
STATUS Indicator:

Steady light	  Orange   Green
Flashing light	 [      ]] cycles

Remote control model number:

Signal cable

NEC standard or other manufacturer’s cable?
Model number:            Length:        inch/m

Distribution amplifier
Model number:

Switcher
Model number:

Adapter
Model number:

Installation environment

Screen size:			   inch
Screen type:	  White matte   Beads   Polarization
	  Wide angle   High contrast
 Throw distance:		  feet/inch/m
 Orientation:	  Ceiling mount   Desktop
Power outlet connection:

	 Connected directly to wall outlet
	 Connected to power cord extender or other (the 

number of connected equipment______________)
	 Connected to a power cord reel or other (the number 

of connected equipment______________)

Computer

Manufacturer:

Model number:

Notebook PC  / Desktop 

Native resolution:

Refresh rate:

Video adapter:

Other:

Video equipment

VCR, DVD player, Video camera, Video game or other

Manufacturer:

Model number:

Projector PC

DVD player
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❽ TCO Certification
Some models in this product family are TCO certified. All TCO certified models have the TCO mark on the marking 
plate (on the bottom of the product). To see a list of our TCO certified projectors and their TCO Certification (in English 
only), visit our website at http://www.nec-display.com/ap/en_projector/tco/index.html
The TCO certification, designed by TCO Development, is an international environmental and ergonomics standard 
for IT equipment. 
In some cases we may post a list of TCO certified models on our website before the TCO mark is placed on the prod-
uct. This difference in timing is related to the date certification is received compared with the projectors manufacturing 
date.

http://www.nec-display.com/ap/en_projector/tco/index.html
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❾ REGISTER YOUR PROJECTOR! (for residents in the United 
States, Canada, and Mexico)

Please take time to register your new projector. This will activate your limited parts and labor warranty and InstaCare 
service program.
Visit our web site at www.necdisplay.com, click on support center/register product and submit your completed form 
online.
Upon receipt, we will send a confirmation letter with all the details you will need to take advantage of fast, reliable 
warranty and service programs from the industry leader, NEC Display Solutions of America, Inc.



© NEC Display Solutions, Ltd. 2013 7N952001
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